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PREFACE

Thank you for choosing this JAVAD GNSS product. The materials available in this Software Manual (the
“Manual”) have been prepared by JAVAD GNSS for owners of JAVAD GNSS products. It is designed to
assist owners with the operating of the Justin Link Software and its use is subject to these terms and
conditions (the “Terms and Conditions™).

Note: Please read these Terms and Conditions carefully.

Terms and Gonditions

COPYRIGHT - All information contained in this Manual is the intellectual property of, and
copyrighted material of JAVAD GNSS. All rights are reserved. You may not use, access, copy,
store, display, create derivative works of, sell, modify, publish, distribute, or allow any third
party access to, any graphics, content, information or data in this Manual without JAVAD
GNSS’ express written consent and may only use such information for the operation of your
software. The information and data in this Manual are a valuable asset of JAVAD GNSS and
are developed by the expenditure of considerable work, time and money, and are the result of
original selection, coordination and arrangement by JAVAD GNSS.

TRADEMARKS — Justin Link™_ JAVAD GNSS® are trademarks or registered trademarks of
JAVAD GNSS. Windows® is a registered trademark of Microsoft Corporation, Bluetooth®
word mark is owned by the Bluetooth SIG, Inc. Product and company names mentioned herein
may be trademarks of their respective owners.

DISCLAIMER OF WARRANTY - EXCEPT FOR ANY WARRANTIES IN THIS MANUAL
OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL AND
SOFTWARE ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. JAVAD
GNSS DISCLAIMS ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR USE OR PURPOSE. JAVAD GNSS AND ITS DISTRIBUTORS
SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS
CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL.
SUCH DISCLAIMED DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME,
LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR REVENUE, OR
LOSS OF THE PRODUCT'S USE. IN ADDITION, JAVAD GNSS IS NOT RESPONSIBLE OR
LIABLE FOR DAMAGES OR COSTS INCURRED IN CONNECTION WITH OBTAINING
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE,
OR ANY OTHER COSTS. IN ANY EVENT, JAVAD GNSS SHALL HAVE NO LIABILITY



Preface
About this Manual

FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN
EXCESS OF THE PURCHASE PRICE FOR THE TRACY SOFTWARE.

LICENSE AGREEMENT - Use of any computer programs or software supplied by JAVAD
GNSS or downloaded from a JAVAD GNSS website (the “Software”) in connection with the
JAVAD GNSS receivers constitutes acceptance of these Terms and Conditions in this Manual
and an agreement to abide by these Terms and Conditions. The user is granted a personal,
non-exclusive, non-transferable license to use such Software under the terms stated herein and
in any case only with a single computer. You may not assign or transfer the Software or this
license without the express written consent of JAVAD GNSS. This license is effective until
terminated. You may terminate the license at any time by destroying the Software and
Manual. JAVAD GNSS may terminate the license if you fail to comply with any of the Terms
or Conditions. You agree to destroy the Software and manual upon termination of your use of
software. All ownership, copyright and other intellectual property rights in and to the
Software belong to JAVAD GNSS. If these license terms are not acceptable, return any unused
software and manual.

CONFIDENTIALITY - This Manual, its contents and the Software (collectively, the
“Confidential Information”) are the confidential and proprietary information of JAVAD
GNSS. You agree to treat JAVAD GNSS' Confidential Information with a degree of care no
less stringent that the degree of care you would use in safeguarding your own most valuable
trade secrets. Nothing in this paragraph shall restrict you from disclosing Confidential
Information to your employees as may be necessary or appropriate to operate Justin Link
Software. Such employees must also keep the Confidentiality Information confidential. In the
event you become legally compelled to disclose any of the Confidential Information, you shall
give JAVAD GNSS immediate notice so that it may seek a protective order or other
appropriate remedy.

WEBSITE; OTHER STATEMENTS — No statement contained at the JAVAD GNSS website (or
any other website) or in any other advertisements or JAVAD GNSS literature or made by an
employee or independent contractor of JAVAD GNSS modifies these Terms and Conditions
(including the Software license, warranty and limitation of liability).

MISCELLANEOUS - The above Terms and Conditions may be amended, modified,
superseded, or canceled, at any time by JAVAD GNSS. The above Terms and Conditions will
be governed by, and construed in accordance with, the laws of the State of California, without
reference to conflict of laws.

About this Manual

Symbols and Typographic Conventions

This Manual uses the following text conventions:

Example Description.
About Titles of dialog windows/boxes, names of menu options.
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Chapter 0
Screen Captures

This Manual includes sample screen captures. Your actual screen can look slightly different
from the sample screen due to the receiver you have connected, operating system used and
settings you have specified. This is normal and not a cause for concern.

Technical Support

If you have a problem and cannot find the information you need in the product documentation,
contact your local dealer. Alternatively, request technical support using the JAVAD GNSS
World Wide Web site at: www.javad.com.

To contact JAVAD GNSS Customer Support use the QUESTIONS button available on the
www.javad.com.

OEM DEALERS CONTACT LOGIN
RECEIVERS UPDATE OPTIONS NEWS PROFILE
ANTENNAS PRICES WEB CART
SOFTWARE ADVANCED EVENTS ORDERS

ACCESSORIES PUBLICATIONS ARTS&SLIDES JNS QUESTIONS

[l Ask us questions and view our answers from over 20 highly qualified specialists
(including Javad himself). It is much better than e-mails, or phone calls




INTRODUCTION

1. Justin Link Software

Justin Link software is based on the post-processing software Justin and it is designed for data exchange
between PC and TRIUMPH-VS/LS and Victor. Justin Link, like Justin, has all GIS-based tool for
viewing, editing and output data, and user-friendly interface makes it easy to work with different kinds of
information: vector and raster maps, field data, etc.

The main function of the program is to convert the information in different formats (with a possibility of
editing this information) and import/export from/to different devices, for example, TRIUMPH-VS/LS.
GNSS data processing, network adjustment and creation of local coordinate systems Justin Link does not
support, but for projects created via Justin software, you can view the results of the post-processing and
adjustment of geodetic networks.

2. System Requirements

Before installing and running Justin Link, be sure that, your computer satisfies the following
requirements:

* QOperating System:
* Windows XP with Service Pack 2 (SP2) or higher
* Windows XP 64-bit with Service Pack 2 (SP2) or higher
e Windows 7, 8 32-bit
¢ Windows 7, 8 64-bit
* Memory:
* Windows XP, 7 32-bit — 1 megabytes (MB) - 4 MB
* Windows XP, 7, 8 64-bit—4 - 8 MB
Hard Drive Space:
¢ Windows XP,7 32-bit — 100 GB
» Windows XP,7 64-bit — 200 GB
Display:
* Super VGA (1280 x 800) or higher-resolution monitor with 256 colors
Peripherals:

* Modem or Internet connection (optional)
* Microsoft Mouse, Microsoft IntelliMouse, or compatible pointing device



GENERAL DESCRIPTION

1. Main window

Main window appears after program started. The program window elements are menu items, buttons,
map and project pane:
Menu Tool har

103 st Link - My projecl o~ N o= =

Project  Map View Tools Options Help

BB Ao ol ¢ |FSRB| 2 ~2@ 0|20z FND &

| [Russia PZ90(PZ30) | Actve layer A

| £ source [ ) Map |5 sirvey |
L

Tab pane Map panel

Figure 1. Main window



General Description
Main window

1.1. Main Menu

Click on the menu item, to call items list. The items of main menu are the following:

* Project. Use this item to open and close projects, to import and export files, to view project
properties and start export layers to many popular GIS/CAD format and view project in Google
Earth.

rl:l Justin Link - [1]

Project IMap View Tools Options Help
I__ New
4] Open

Close
v Properties

i Import files
Export to... »
G Google Earth

Exit Alt+X

C:\Justin Link Projects\1.jpr

Figure 2. Project

* Map. This item contents tools you need to work with the map: distance measuring, panning,
centering, zooming, etc.

Map | View Tools Options
e% Zoomin
| #= Zoomout
. {") Move
E &) Show entire network
Set map position / size
E & Distance
E ¥ Add layer

Default layers style

Figure 3. Map
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General Description
Main window

* Set map position/ size menu item opens the window, where window size, zoom, and the center

map coordinates in the specified coordinate system can be set.

I Set map position / size X
Zoom {window width) 1148,721 m
Scale lcm= 41,976 m

BLH
. @N " [ o o
latiude 20 54 o I A
Longitude (@E = 3541% j3.41" 33 593015 21"
= s “F =8 Kl

Height ) 0,0000 meters

Russia PZ90(PZ90)

[ o H Cancel ]

Figure 4. Set map position/size

* Default layer styles menu item cancels the style entered by the operator, and restores the default
style for all layers except the dynamic and added layers.

* View. This menu item is designed to hide or make visible the basic elements of the window and set
of panes. Panes become visible when the box next to the appropriate item is checked. The full

description of the functions of menu items see in appropriate sections below.

I\ﬁew |Tcols Options

Project
Map
Receiver list
Media
Vectors

TVS

NMEA

NEHEEEE

Figure 5. View

* Tools. Georeferencing of register raster image. The full description of Justin Link functions see in

appropriate sections below.

Tools |Options Help

{ & Register raster image

Figure 6. Tools
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General Description
Main window

* Options. This menu item is designed to setup the various program parameters, operate coordinate
systems and datums, manage reference points database and antenna database management. More
detailed description see in “Application” on page 45.

Options | Help

»  Application
Projection
Datum

A Reference points
Antenna list

Figure 7. Options
* Help. Opens the Justin Link About window with the software version

- I About - X
(% About

Program:  Justin Link

Version: 1.99.122.50

J Mail to: support@javad.com

v Vo)

—

Figure 8. Help

* Windows. This item is invisible by the first start of the program. It appears when hidden windows

involve by operations. To make these windows visible, select the Windows menu item and point
the window you want to see.

Windows | Help

Classifier |

Coordinates clipboard |

Figure 9. Windows

1.2. Toolbar

The toolbar consists of many buttons, through which the user can access the following program functions:
- Create new project.

- Open a project.

Vil
_ - Open the project properties dialog window.

i }" - Import files into a project.

12



General Description
Main window

+Z
- Add layer to map.

- Open the report dialog.

=

- Reference points manager.

¥
o Coordinates calculator.
— - Export layers into Google Earth.
- Link with TRIUMPH-VS/LS in a dialog.

- Link with Tracy in a dialog.
- Select on the map by pointer. Allows selecting an object.

‘;3' - Select on the map by rectangle. Allows multi-selecting objects in the specified rectangle

@ - Cancel selection.

£% | _ Zoom in the map.

#= | _ Zoom out the map.
& : : : .

- Show entire network. Display entire network in the Map pane.
@

- Changes the cursor shape and allows moving the map views.

- Allows changing the cursor to a crosshair and measuring a distance in a project units. The
distance displays in the Status bar.

“ - Open Coordinates clipboard window.

= Legend.

=1 Classifier (see “Classifier” on page 35).
13



General Description

Legend
W
- Multilayer select (all layers became selectable).
| _ snapping mode.
- Undo. Restores last Map View
- Redo (is active after Undo was clicked).
1.3. Map

The Map menu allows the user to operate with the map.

1.4. Tab pane

Tab pane has the following tabs: Data, Map and Survey. It displays accordingly the information for these
tabs.

2. Legend

For convenience work with various types of data for all types the unique conditional symbol is assigned.
To see the symbols (legend), click the button .

14



The Legend window with reference information will appear:

Legend |

Site :
8. Stand-alone
W Plane and height snapped
@ Sohiion snapped
MNet node snapped
& Manual snapped
& Rinex heades snapped
W Plane snapped
W Height snapped
Stop:
W Stand-alone
@ Sohition snapped
@ Met node snapped
® Manual snapped
Feference points :
L Plane and verical
[ Plare
e Vetical
Flecordsets :
4 Static
@ Kinematic
@ Stop k Go
QY Mo position
Pasition by epochs
Adjustment
/ MNetibs
Trajecton
Solution :
“% Kinematic
A Static
Wector :
FKinematic
A Static
GNSS Stations :
(& Contiruusly Operating Refere:
@& Scipps Orbit 2nd Permanent &
Events :
@ Event

Figure 10. Legend

Below is the description of all items of the Legend window:

* Site (a particular place on the earth’s surface, a point).

(1]

General Description
Legend

— Stand-alone. The site which coordinates are not entered by the operator and are calculated

as standalone. The coordinates of such point are two opportunities: a) if the flag Compute coordi-
nates is unchecked, the raw receiver coordinates in the recorded file for each epoch are averaged,

and b) if the flag is set, the post-processed coordinates are averaged.

W — Plane and height snapped. The point with inherited from 3D reference point position.

™ — Plane snapped. The point with inherited from plane reference point position.

w _ Height snapped. The point with inherited from height reference point position.

@ _ solution snapped. Coordinates of the point comes from the end of solution.

& — Manual snapped - a point with the manually entered coordinates.

— Net node snapped. Coordinates of the point comes from adjustment.

& _RINEX header snapped - a point with the coordinates taken from the header of RINEX file.

15



General Description

Legend

16

Stop is a point which position is calculated as epochs average position of kinematic position.
“ — Stand-alone. Stop position is calculated with receiver data.

“ — Solution snapped. Solution snapped Stop has post-processed position.

“ — Net node snapped. Adjusted Stop gets coordinates as a result of adjustment of kinematic
postprocessed solutions (multiple bases).

® _ Manual snapping. Manually entered coordinates of Stop.

Reference point (a point with the fixed coordinates in defined coordinate system for the purpose
of providing geodetic reference for other coordinates calculation).

4 _ Plane and height. 3D fixed point.
B — Plane. 2D fixed point.

® _ \ertical. Height fixed point.
Recordsets (sets of raw GNSS data).

“» — Static. Recordset related to “Criterion for static”. Two recordsets with time overlap data gen-
erate “\Vectors”.

“ — Kinematic. Kinematic recordset is a not Static one.
% — Stop&Go. Kinematic recordset with markers pointed.

& — No position. Recordset has no ephemeris data or standalone solution is not accessible.
Solution. (Data post-processed solution for vector)

¥ — Kinematic. Kinematic data post-processed solution.
Adjustment (Adjustment generated objects).

7 _ Net edges. Net nodes are results of static solutions adjustment.

— Trajectory. It is a result of kinematic data adjustment in multiple base mode.
Vector

—Kinematic. Kinematic trajectory is a track or epoch by epoch positions (Justin calculated or
coming with raw GNSS data).

— Static. Static vector is an object created for two static recordsets with overlapped time..
GNSS Stations. Permanent operating stations delivering GNSS data.

» _ Continuously Operating Reference Station (CORS).

* _ Scripps Orbit and Permanent Array Center (SOPAC).

— Event or time marker is a point created for non epochs instant time moment



General Description
Source

3. Source

The Source tab is used to display a list of data imported into the project and raw data management:
picking, thinning, jps and RINEX conversion. After tab activation it becomes accessible object tree:

3 Justin Link - [1]

Project Map View Tools Options

2 || R ® 8 A

& g 04.07,2012

¥ 31

=g 10.07.2012
€ dima2

g 12.07.2012

45 dimal.n

£ 24.08.2012

&) NormT9

£ source [ Map [ g Survey

Figure 11. Data and objects tree

The general node is the name of the project. Its subnodes are groups that are created by the selected
method of sorting the data. The data may be sorted by days or by receivers. This tab displays a sample of
imported raw GNSS data that are named Recordsets.

There are three types of Recordsets in Justin Link:

W — Static
' — Kinematic
¥ — Stop&Go
* - others recordsets
Recordsets for which it is impossible to calculate the position are marked ©.

By right-clicking on the project name, the following control will be accessible:

-
3 Justin Link - [1]

Project Map View Tools Options Help

A|HRESAS P

I i Close project
Properties
ol
Ll Import files
13 Deletesall

=1 Sort By F  Day
[T Receiver

[ Source |4 Map | gy Survey

Figure 12. Right-click menu
* Close the project.
* Open Project properties.
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General Description
Source

* Import files into the project.
* Delete all data from the project
» Sort the Recordsets by date or by receiver.

By right-clicking on the name of the next level node, corresponding to the creation date of files, you can
get access to the following:

[ [ Justin Link - [1] __‘_

Project Map View Tools Options Help

D MBRE®AC

e-0J1
R 4 Bd N Delete Del
Ku
x Po Common time

4y Point_3
4 Yellow Stone 90

Figure 13. Right button menu

* Removing all data from the project (all data with the measurements started this day).
* View common observation time for all files started this day:

(53 Source: 16022011 = i Y oo )
(=M
Pt 3 |SrE———
| oo e
I ===
&

i

0820 G230 0E40 0ESH 0S00 90 0920 0930 OG4D DRSD 1000 10010 1020 10D 1080 105D
UTC tme:

Figure 14. Common time chart
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General Description
Source

By right-clicking on the name of the next level node with Recordset item, you can get access to the
following:

.
O3 Justin Link - [1]

Project Map View Tools Options Help

7] || & 8| A G

=[] 1
2 16.02.2011
o= _
ap Kurk N Properties

4 Poin
4 Poin W Delete Del

Yelic
v Export to JPS

Export to RINEX

~ Zoom to..

Show track

Figure 15. Right button menu for recordset

* Open properties for each Recordset;

Delete recordset;

Export to JPS;

Export to RINEX (see “Export recordset to RINEX” on page 21);
Zoom the map area with the coordinates of selected Recordset;

Show track on a map (see “Show track™ on page 22);
* Remove track.

Recordset properties

By clicking on the Properties menu item, appears Recordset properties window for selected recordset:

| O Recordset properties : Base ﬂq
General Recefver | Antenna i:
Coordnates | Observation bme |

File nama D VGIS Uustin Link manual\? Data_Fies

Alas Base

Site: Base

Comment

Dbserver LInkricnir-

Agency Lirkricnain

@ Static Kinemalic Stop & Go

o) [ oo

Figure 16. Recordset properties. General tab
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General Description
Source

* The General tab of this window provides an overview of the Recordset properties and allows
changing the type: Statics, Kinematic and Stop&Go. Here one is able to add comment and put

down an alias that is label which appears on the map.
* The Receiver tab contains information about the receiver and the minimum number of satellites
for one epoch during the session.

rD Recordset properties : Base EE1

_ Geowd |[ e Amewa |

Coordinates | Cbservation time

Type TRILUMPHL

m AW P S TV RGTUTALG

Frmware verson 52,5 Jan, 26,2011

Miremum mumber of satelites 1)

Figure 17. Recordset properties. General

* The Antenna tab shows information about antenna type, height and offsets. Here you can change
the type of antenna or get additional information about antennas, clicking the button E], which
opens the window with antenna properties:

"I Recordset properties : Base ol
General | Recater ”_ .»\’l_wvbs'na
Coordinates | Chservation time |

Serial rumber Arikngwn-

Measured height m 0.0000
Vertical (4RP) -
Measired offsets from marker
Vertical, m 0.0000
Merth, m 0.0000
East, m 0.0000

Figure 18. Recordset properties. Antenna
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General Description
Source

* The Coordinates tab contains averaged coordinates, calculated for all epochs of the Recordset
(excluding the most unreliable, which are rejected). The coordinates can be can be in any of
Coordinate Systems valid for the project: geocentric, ellipsoidal or grid.

rI'.'I Recordset properties : Base Q
: General | Feceiver | Antenna | [
[ cowdnses  observatonme |
| wz |[an o
|
| |

Latncde BN 55 3] wmmosmal |
‘ longiude B'E  378* ng|  sasmemag]
Hesght 1768153 meters
| |Russia Pz30(PZ0) -
[ ][ come

Figure 19. Recordset properties. Coordinates

* The Observation time tab shows the start and final epochs time of the recordset, recording interval
and the number of epochs in the recordset:

- 4
D Recordset properties : Base g
General I Recener | Antenns |
Coordnates | Obearvatentme |
Begintime  16.02.2011 13 09:13:00
| Edtme 16.02.2011 3 10:24:05
Interval 1000 |...| sec
‘ Epoths 4266
| o= Cancel
; ]
a

Figure 20. Recordset properties. Observation time

Export recordset to RINEX

The Export to RINEX menu item allows exporting the recordset to RINEX format, selecting satellites and
type of measurement, which should be excluded from the file and will be rejected. The invalid satellites

21



General Description
Source

should be marked with red and the observations unmarked. Additionally, the start time and final time, and
recording interval can be set. Clicking Ok button runs the export:

Sabelites Dbgervabors Farnsatees
gha L] = A verson 231 =

1 _ 2493 4 5igsga @O Eiy

7. Bigd gl 1M@A e @0 51 [7Dsable free events

‘:-; :’ ;: gﬂ"; #cz | Enabie known free events
wiie L4 L i @ 7] 7] Dimabole orpatons

5% Tg® 8 W "z “':'t: D,i 2: | Disable clock offet
g 3 M B % - || Add leading neros o svn

7 Lt ] Use CA phase and daier
GLOPASS =} Wiot

1@2 3 _4@s sga NP FU ik

7. 808 0gngizga  [Fc Starttme 1692201181318
i3 W5 TGigiTgs Fire FL2 Hoz [Fs2 Fral tme 16.02,2011 10:24:20
wigan Nz n_ N

BB X B _B N Tuterval 1

r) s
Path £\ Justn Link Progects! in |

o J[ cma

Figure 21. Export to RINEX

Show track

This menu item shows the epoch by epoch positions:

Project Map View Tools Options Windows Help

Dav|ReBACTYOES WK @F]

i-_.,_ﬂl | .
-:aEuzml

-

£ souce |41 Map | s Survey| | Lathude: v s5os720. 771322° Longtude: £ 3753135, 4466047 |

Figure 22. Show track
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General Description
Map

4. Map

The Map tab has two general nodes. In the Project group there are eleven permanent layers as well as
dynamics layers, created by user. The Added layers group includes all involved into the project layers
through option “Add Layer”.

-

3 Justin Link - [1]

Project Map View Tools Options Windows

| BRER AT

¥ Positon

W Site

¥ Stop

W Reference

¥ Recordset

¥ Geoid

¥ Error ellipse

¥ Edge

W Trajectory

W Solution

¥ Vector

D:YGIS Dustin Link manual\2 Data_Files for Justin

=-4 ) Added Layers

¥ 100k-pS50-109_110.TAB

[ forest

2 SqUATeS

L] Source | ) Map |Ma Survey

Figure 23. Map tab
Permanent layers are the following (see description of the objects in “Legend” on page 14):

* Site - set of point objects which contains Recordset. A Several Recordsets can be assigned to
many Recordsets related Tolerance criteria.

* Stop - set of point objects related to tagged time interval in kinematic data.

* Reference — set of reference points.

* Recordset - Special layer for show/remove track Recordset option.

* Geoid - Geoid boundary.

» Error ellipse used to view adjustment statistics.

» Edge - set of line objects to view adjustment data.

* Trajectory - points for adjusted kinematic solution.

* Solution - static (lines) and kinematic (collection of points) processed results.

* Vector - candidate for postprocessing: lines for static data and tracks for kinematic data.

* Position - real time positions which comes from receiver or based on Justin real time solutions
(cloud computation).

Dynamic layers are sets of the following objects: points, polylines, polygons, used for data import and
export. Added layers can be either raster (aerial/space images, scanned map copies) or vector maps.
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Map

Layers can be made visible or hidden, depending on check box next to the layer title. Option can be
activated with double clicking.

Layers, with . : icon can be made visible/hidden by clicking on this icon. If the icon is white - :, the layer
is visible. If the icon is gray - :, the layer is hidden.

For the Added layers there is an order of drawing. The bottom layer in the list is drawn first. Next is
second from the bottom and consistently to the first layer in the list. To move a layer in the list up/down,
put the cursor on the layer item, and drag it with the mouse

SBB] Added Layers] ' ) Added Layers 54) AddedLayers
v 100k--p50-109_110.TAB F 100k-p50-109_110.TAE W forest :
Hois v B oo s o)
[¥ squares W squares ‘E F squares

Figure 24. Added layer arrangement

Both groups, Project and Added layers have functions for working with layers in the group. To access
these features, should put the cursor on the group name and press the right mouse button (and then, if
necessary, select any item in the dialog box.)

For Project group all layers can be made visible at once; empty and dynamic layers can be deleted
optionally:

"0 Justin Link - (1

iPr-:-_jg:t Map View Tools Options Windows

JIBRERAST

R Rt Show Al Layers
g f‘ ®  Delete Empty Layers
St
F R N Delete All Dinarmic Layers

I Recordset

Figure 25. Right button menu. Project
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General Description
Map

For Added layers group all layers can be removed, new layers can be added, and the layers with the
following information can be added:

-

0 Justin Link - [1]
Project Map View Tools Options Windows

= __] Project

- [¥| Position
|7 Site
|7 Stop
- |w Reference
-V Recordset
[V Geoid
- [w Error ellipse
----- ¥ Edge
. [W| Trajectory
- [v Solution
- [¥ Vector
-+ Di\GIS\ustin Link manual'\2 Data_Files for Justin
[ forest | 3 Removeall Del
-] 100k-p5| & Add layer
[V squares

G/ Add Google layer

¥ (NS5 Stations

L. Reference points

4| i | b

| %] 50urce| ) Map |k Survey|

Figure 26. Right button menu. Added layers

1. Add Google layer - Space image of the area, related the size of Map Pane. Every time you click an
item Justin Link makes a Google Map snapshot according Map Window size and a position. After
panning or zooming Map Window force Refresh option to get new image.

If an error occurred while downloading the image, it will not shown on the map. In this case, you
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General Description
Map

need to re-call function Add Google layer or right-click on the Google map layer name and click-

ing Refresh.
CLamse B W Y
Dhw BB ACTEE S |WRR|H @0 0E] 4|

Project Map View Tools Options Help
EL_] Project

W Position

W Site

p Stop

v Reference

¥ Recordset

|7 Geoid

. Error ellipse

p Edge

¥ Trajectory

¥ Selution
W Vector

-4 ) Added Layers

i [

: Rl ol 2 -
H i1 Source | { ) Map |l Survey| Latitude: N 55°49'18.272860" Longitude: E 37°26'43.859035" | [ wis 84(wesa4) || Active layer
i

e — —— — e—

Figure 27. Google map

2. GNSS Stations - & - Continuously Operating Reference Station (CORS), & Scripps Orbit and
Permanent Array Center (SOPAC).

Project Map View Tocls Options Help

2 V| BERACTYOR S WRB|)2@0 | SOEZI+ [T

[ = Project
FF Positon
7 Site & mdva

. Swp . ¥urkne | 256,579

g:j;x ‘\i'ml 173,766
F Genid
F Emor clipse & wef
W Edge
F Tragectory
¥ Schstion
R Vecior
=4 ) Added Layers

& mabi,
Okiometes 20 40
——

neEsre. ;ﬁ_ Survey | | Labiude: N 55T0100.609902° Longitude: E 35%4145, 192037 | | WS s4{wess4) Active layer Al
—_—

Figure 28. CORS
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General Description

Map

3. Reference points - reference points available for use in the program (view of all program reference

points accessible via Reference Points Manager):

3 Justin Link - [1]

Project Map View Tools Options Windows Help

] |4 A “r + s @G O g @"b R \\\3 @ Vril @ fi (1]

El-Ll ] Project

- [w Position
p’ Site
-[¥ Stop
- [¥ Reference LK ff 214954
W Recordset .l
[ Geoid
- [W Error ellipse
.| Edge : zwen, ff 204,994
- [¥ Trajectory =
W Solution

o [w Vector 1B ff 273126
=k ) Added Layers =

¢ mdvo, j 254.785

[ E1 source | () map | g Survey| Latitude: M 55°10°50. 5226967 Longitude: E 37°1312.2892307 | [ WGS 84(WG584)

Figure 29. Reference points

To get access to a list of options assigned to the layer click it and inspect a list. Layers properties differ
depending on layer type. There three main types of layers in Justin Link - permanent, dynamic, and
added. Permanent layers are generated automatically for a new project. Dynamic layers are created for
survey objects and vector maps which are imported from Tracy software, TRIUMPH-VS/LS application

and from files.

Below is description of layer properties:

o TR
E|u ) Added Laye \ Style
i W] Referen
Drop layer Del
s Show entire layer
Hide all layers except...
Rename
Export Export to TVS file
Volume Export to TVS
Export to Tracy
ESRI Shape
Maplnfo TAB
MIF/MID
DXF
Kml
1| [0 3 PNEZD
| i1 Source| ) Map |‘B Sur\-'ey| Lati T

Figure 30. Right button menu for layers

* Style (available for all layers). Opens the Layer style for vector layers and Raster style window for

images.
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General Description

Map

28

Show entire layer (available for all layers except the error ellipses layer) scales and displays all
items within the selected layer of the map.

Hide all layers except... (for all layers) hides all layers except the selected layer.

Blunder style (for layer edge) displays the Layer style window for blunder.

Only fixed (for layer Solution). If selected, only fixed kinematic solutions will be displayed. If not
selected, all the solutions are shown.

Drop layer (for all layers except the permanent) removes the selected layer.

Rename (for dynamic layers). Used to change the layer's name. To call this function, double-click
on the layer name.

Export (for dynamic layers) activates export functions for the selected layer, opens dialog window
with exchange formats.

Volume (for dynamic layers) displays a minimum volume covering all points in a layer (convex) in
cubic meters.

Georeferencing (for raster layers) activates the Georeferencing control panel for raster image.

TVS Background (for raster layers) saves raster image to TRIUMPH-VS/LS Background format
(*. Sqlitedb). This menu item opens Save as window, in which you should select the folder and
type the name of raster file:

Save As @@
Savejn | 1) test v| Q S e [~
w8
Iy Computer
.:‘] File name: .test v
MyMetwork | Saveastpe | TVS Background [“sgliedb] v

Figure 31. Save As window

* Refresh (for Google map item): refreshes raster image for the new position of the map.



4.1. Style settings

For vector layers, Layer style window view varies.

General Description
Map

* In the Style tab, you can customize the properties (font, color, etc.) of the objects displayed on the

"

map.

[ Layer style

Enable labels

Along @ Mone

Position ") Top left
) Center left
~) Bottom left

Offset ols

Font Tahoma

") Parallel ) Multisegment
") Top center 7) Top right

@ Center %) Center right
~) Bottom center () Bottom right
0=

Background
@) None ") Halo Box
Color he quick brawn fox jumps aver the lazy d
Effects
[T Bold
[ 1talic
[ shadow
Figure 32. Layer style

Check Enable labels to show text data on the map.

In Values tab can be defined a set of labels for an object on the map. Select on the left the parameter and
click arrow button | g | to move/remove an items. You can ordered labels on the map with up and down

arrows.

3 Layer style

=)

Labels
Style || Values

Available

On map

Receiver
sig|

X

Receiver

Y

Zz

Orthometric height
Comment

Begin time

End time

€ 13

Separator

s o)

Figure 33. Layer style values
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General Description
Map

* In the Separator field the separator between shown on the map labels can be specified. Click Ok
to accept new label style, or Cancel to return to the previous configuration.

* In the Objects tab color and other parameters of the shown on the map object are specified:

3 Layee stjle e O Loy ityle i

[r—

[ Comman e

LT & L v

sy _ e -
Figure 34. Objects tab
* For raster layers, the style window is called Raster style:
"3 Raster style SSrol )
W) | r5 22 @H +
Transparency 0 %

4 b

|:| Use transparent colar

(@ Mone
Red
Green
Blue

oK l l Cancel

Figure 35. Raster style

The color transparency of raster image can be customized.
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General Description
Survey

5. Survey

The Survey tab includes the following object tree:

3 Justin Link - [1]

Project Map View Tools Options Help

) v BERAC

=03 UDE_25758 A
-4 Aginsk Al
=+, Ageiske. txt

[y Boikow2
[H-4gg Dinamic Layers
(-4 Fb2
= Kzs2012jan20
Layer 0
----- s Tys-1
----- * Tys-2
----- * Tys-3
----- s Tys-4
----- * Tws-5
----- & Tvs-5
----- * Tys-7
EJ"iﬁ- LocalTest
=] Test
Layer 0
™ t_vellow Stone 84
™ t_Yellow Stone 856
™ t_vellow Stone 87
™ t_vellow Stone 50
* Testl

. * Testd
| { | source | [ ] Map=l k Survey |

Figure 36. Survey tah
The main nodes are:

o I -Receiver
o 4. Work - Folder

The sub node is Map - M . It has the following sub nodes:
* Layers - with the following objects:
* point * ,
* polyline T,
* parcel D,

Each item of the tree can be visible or hidden. To make the object visible or hide it, double click on the
appropriate icon.

If the icon is active (l:I e ), the layer is visible.
Otherwise icon is gray (=2 o ), the layer is hidden.
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General Description
Survey

All objects in the Survey tab have the same set of functions applicable to them (exception is Work, which
does not have item Properties). The object functions can be opened by right button clicking and selecting

from the list of items.
» Properties (unaccessible for - Work). Opens the Property window (see. “Property” on page 32).
Style. Opens Layer style window (see “Style settings” on page 29).
Delete. Deletes selected object.
Zoom. Shows all objects on the map.
Google Speech. Recognition audio information with the Google Speech Recognition service (see
“Audio information recognition” on page 37).
* Associated. Denied repetition of Google Speech Recognition preserve against to update the field.
* Associate by. Indicates correspondence between items and Classifier (see “Classifier” on page
35).
* View table. Opens the TVS table (see “TVS Table” on page 43) for selected objects.
» Export. Opens Export window (see “Exporting data to exchange formats” on page 78).

5.1. Property

To see object properties right-click on the highlighted object and select Property menu item:

3 Justin Link - [1]
Project Map View Tools Options !

B

=01 UDE_25758

i |_a‘ Property |

“ NE O Style

i % Delete Del

""" s Zoom

& Google Speech
Associated 4
E":' Associate by 3

HES View Table

+-€_3 PROPRIETAR
s SUPRAFATA
iw 0,58 ha
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General Description
Survey

Figure 37. Right button menu. Property

Depending on the object type the Property window’s view varies:

Receiver B - Dialog for metadata, Map = Dialog for operation in group with
point snapping, offsets, antenna snapping, antenna properties, offsets

OSVHIHAKTASSAV2FSLAZSWKAUDE
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General Description
Survey

Layer - Group operation with a layer

selected object

Object 7" or [ - Single operation with

—

1 Property ﬂ' 3 Piopedty - Dindrmias Liyer - Layeill -
Layer FRover antenna .lé:-e:d_ Florepr | Rereer arvierna |
Loyer name  Ageisho:, bt Proanil rues

| [, P

| Arirbules
| |
Hisinlie
Snaped = - it
. - Tt AL AT B+
| £’ Base Snap to... | | #'snapto
L !
4

In the edit fields of the Properties window you can change the data, click OK to accept and save the

changes, or Cancel to cancel editing

For points * there are additional tabs in the Property window: Master and Rover.

In the Master tab are displayed the coordinates of base point, according which Rover coordinates were

calculated.

The Rover tab displays the coordinates of the object. In both boxes next to the active window there are
strings with information about the item to which the object is snapped (otherwise [None] will be shown).

23 Propesty « Dunamas Liyer - Layer]? -

[l R | Rover sirra |

X Propeny « Gonemnic Livies - Laymed2 - ‘ﬂ 3 Froperty - Diname: Layers - Layerld -
o[ e | Gerera | v [[oer wlirs
Ll | B 3 sl e
Lastcke s o2 s
Lomgae wal" ug xeowi ERmE R
e ELIHE ety St ()
Measured oMty from marker
P paae = e, m
o, -
MG, m g metE Lest.
Tipe
waped b - Piore]
' ey 10,
[ = carcsl | =

.

o000 |

0,0000

The coordinates can be shown in geocentric, ellipsoidal, grid or local systems. To select a particular
system, select the appropriate tab. A check mark Associate indicates that this object will be used to re-call
the function Google Speech and Associate.
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General Description
Survey

For the windows above, there is another category of tabs. Snap base to... and Snap to... Clicking on them
opens the window [None]:

0 - [Neoc) | o=h S | (o g (E=Sfcy )
o s o - B SetPenracens Foaten
Reference poris
L TS Base (326,13 m)
5 TV5 Base (32561 m)

&, TVE Base (836,62 m)
1 1vs (= )
o V5 Base (826,61 m)
TS Base (14636, 14m)
TVE Base (14638, 18 m)

TVS Base (1 723 173.85m)
m|fan o | e | oz |[an e | tocal
lasade  © ; s’ vz mesmosg| Lastude & wal' w2 swnengl
longide ®E 372" 313" aamessiz|’ Longiude ws]" 123" mosswzal”

W 5 3 -
Mot 75,7483 meters Heght 602951 meters
7 param - 7 param

Fres Snap to.., | cConen | Free Snap to.. Cancel

So there are some opportunities to set point position - get from receiver, snap to some objects, manual
input and postprocessing. You can modify alone point position with Snap fo..Base snap to.. Option affects
to all points referred to the base. Every survey point position are calculated in RTK or static
postprocessing relative some base coordinates.

To implement the inverse operation, click Free, base coordinate point or object will have the value that
they had before snapping. To cancel all changes and close the [None] window, click Cancel.

5.2. Classifier

Classifier - is a customer structured table of defined style. Object attributes are - scale, number, code,
description, symbol. To activate the classifiers table, click Classifier icon |— el

Classifier manager appears:

Classifier @

=g * X
i

iyl | Default

Figure 38. Classifier
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General Description
Survey

To add the row and new classifier, click g | to delete selected row, click u .

Focus on one of the table fields and add appropriate information (scale, code, description). To input a
symbol double click to the appropriate field, select the picture file and click Open. The classifiers table
will be completed:

rl:l Open [ﬂ

Look in: , pngcollection - O ¥ e - [40:40)

L
=

Recent Places

DESktDp Barrel column contfer Sleckuous tres _

m

. :\:J Classifier @
Libraries ‘J_,_] Al p
[} | Default * %
i L 2500 1 deciduous tree

==
Computer i ; t —
*’ - 2500 2 wooden pole

i
Qk metal pole shrub well

p— @
»

Metwork 2500 3 AppleTree
File name: deciduous tree
Files of type: PNG images (*.png) 2500 4 metal pole I 1
= —
2500 5 well ﬁ

Figure 39. Classifiers table

To recall the classifier click — i and Classifier window appears with all inserted information.
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General Description
Survey

5.3. Audio information recognition

After having imported objects with audio data, this information could be recognizing using Google
Speech option.

To put on the map an attributes data from Classifier, select the layer and call right button menu, then
select Style menu item:

-3 UDE_25758 3
- Adinsk
. .
..... . 1 v Property
..... . 2 z
..... . 3 |2 s
..... !
, Delete Del
..... & 7196 b
..... « 3630 3 Zoom
_____ . 375 & Google Speech
- s 9187 Associated !
- Boikov2
= Layer 0 Associate by '
..... 1 View Table
..... . 10 g
..... « 100 Export
..... « 101
Figure 40. Style

Focus on the values you wish to be shown on the map, e.g. Recognized audio, and click Iif . The

Recognized audio item appears on the right, and the special symbols on the map will have appropriate
label.

3 Layer style @‘
Objects || Labels
style || values Point

Available On map

Mame
Height
X

Y

z

Time
Comment
Attributes

Solution

€1

Separator !

s [ ez

Figure 41. Layer style
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General Description
Survey

To recognize audio click with right button on the layer name and select Google Speech menu item. The
progress bar will show the status of recognition:

—n UDE_25758 =

—k Aginsk
..... . 1 v|  Property 750y,
..... ] A Style B
..... P
..... . 4 % Delete Del Recognition completed —
----- 2L P
----- . 8530 | >
..... « 875 | & Google Speech Cance
""" * 9187 Associated L4

[=h4ag Boikow2

k_ Layer 0 Associate by L

..... . 1 View Table
""" * 10 Export L4
----- s« 100 ——
----- . 101

Figure 42. Google Speech

Classifier symbol will remove on the map last ones:

2 R el o » 3= ' v
crof | s @9 @ l|[®
G
YeBow ﬁlm“'.‘l"ﬁl,_.‘vﬁﬁ
"
-
Tio
Om 1 3
& Aﬂ"njﬂf‘.'l 55%47 54, 4148147 Longitude: € 37731'14.999 144 WGS 84 Actree layer Al
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6. Project Properties

This dialog appears after clicking Project Property or New Project options.

3 Project properties

]

: Ge aIZE Reference points Coordinahesyshems| Time |

MName

Creator

Agency

Created

Full path

Comment

1

04.09.2012 18:58:21

18:58:2

C:Yustin Link Projects),

| oK ‘ | Cancel |

There are four tabs in this dialog:

e General:

* Name - project name.

Figure 43. Project properties

General Description
Project Properties

* Creator and Agency — creator’s/agency name which will be used in reports (can be empty).

* Comments — any comment to the project (can be empty).

* Created — the date the project was created (filled automatically).
* Full path — destination folder where the project is stored. All files created during the operation

with the project will be saved in that folder. To see path click the Browse button | | .

* Reference points tab is designed for adding reference points to the project.

* Coordinate Systems tab is designed for adding to the project coordinate systems.

* Time tab allows selecting time format for the project. The following formats are:

* GPS, Global Positioning System time, is the atomic time scale implemented by the atomic clocks
in the GPS ground control stations and the GPS satellites themselves. GPS time was zero at Oh 6-
Jan-1980 and since it is not perturbed by leap seconds GPS is now ahead of UTC by 15 seconds.
- GPS time in format dd/mm/yyyy hh:mm:ss.sss, e.g: 04/05/2012 11:06:24.567
- GPS time in week’s format www/ssssss.ss (number of the GPS week/seconds from the week
beginning), e.g.: 1686/471984.234
- GPS time in seconds: 1020 164 784.567

* UTC, Coordinated Universal Time.
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General Description
View

* Local time in the format dd/mm/yyyy hh:mm:ss.ss, e.g.: 04/05/2012 11:06:24.567. The local time
zone is selected from the list. Local time differs from UTC by time zone offset.

~
1 Project properties ﬁ

General | Reference points | Coordinate systems | Time

~ GP5 time (dateftime)
) GP5 time

I GP5 time (sec)
@ UTC time

"I Local time

| OK ‘ | Cancel |

Figure 44. Project properties. Time tab

1. View

The list of View menu includes two permanent active items and some additional ones. Permanent items
are Project and Map. They hide/make visible main left/right program pane.
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General Description
View

The next items add a new pane to Map window.

Project Map View Tools Options Help
v REBATOE S INSB| L~ M
= .. Layer 3 - |
L™ She3
E-h TestMap 2
=% Selection
. P1
~w P2
-~ P3
- & P4
% P5
- w PE
-~ PT
- w PB
=L Parcd
. 13
- 14 0 kilometer 200 400 GO0 800 1000 1200
% 15 [ ——— 1
o 18 | Latitude: 5 2152508, 126412" Longitude: W 9°09'18.746036 | | wGs 84 | | active layer |
[_D Parcs i R = B ¥ AR IO =B E RPT . -
: g Map ]Type Object IDbjE[t data time  |Pointname |[Foint data time Layer -
. 1 | Fb2 . mt1 05.07.2012 12:13:49.000 Layer 1
3-[ Parcs | Fb2 . mt2 05.07.2012 12:13:51.000 Layer 1
e 20 | Fb2 . mt3 05.07.2012 12:13:52.000 Layer 1
e 21 | Fb2 . mt4 05.07.2012 12:13:54.001 Layer 1
e 22 | Fbz . mt5 05.07.2012 12:13:56.001 Layer 1
e 13 _| Fb2 . mt6 05.07.2012 12:13:57.999 Layer 1
. 24 ] Fb2 . mt7 05.07.2012 12:13:58.999 Layer 1
e . mts 05.07.2012 12:14:00,999 Layer 1
= Papp =
B E| . mtg 05.07.2012 12:14:02.001 Layer 1|
w3 - o AT
s - |E :
i | Source I (%] Map| ‘m Survey | W Receivers I »N Media I » \c'ecbors| »n VS ‘x NMEA|
Figure 45. View
* Receiver list — opens the Receivers tab with the list of the receivers.
] Receiver 1 Mumber | Serial 1 Firmware version IRover1
TR VS 03IVHZHKTASSAV2FE 25758 3.3.1b4 May, 06,2011 =
TRIUMPH1 SWVVAWHQY SPK353V) 3.2.5 Jan, 26,2011 |_
W Receivers |

Figure 46. Receivers

The Receiver table shows type, serial number and firmware version of receivers. Here receiver
could be marked as a rover either,to prevent vector generation between rovers.

* Media — opens the Media tab, for the purpose of playing of audio information.

D

>PHBIMAD

N Media |

Figure 47. Media
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General Description
View

* Vectors — opens the tab with the vector information. The check mark Enable allows making the
selected vector visible or invisible on the map.

Kurking, | 259.581
Eiel || TmZR
4 Okiometer 2 4 3 g 10 12
| ]
Latitude: M 55°55'10.316300" Longitude: E 37%43'58.8993707 WGES 84 Active layer All
Enable Begin point End point Begin time End time Time span  |Epochs Length -
v Point_3 [ 00:36
= Base Yellow Stone 90 16,02,2011 09:39:48,000 16.02,2011 10:21:42.000 / 00:41:54.0( 2515 56,468
W Base Point_1 16.02,2011 0%:43:47.000 16,02, 2011 10:22:13.000 f 00: 38: 32,00 2313 §3.505 £
W Kurkino Base 16.02.2011 09:13:00.000 16.02.2011 10:24:05.000 f 01:11:05.0( 4266 14644. 145
|7 Kurkino Point_3 16.02.2011 09:46: 16,000 16.02.2011 10:22:16.000/ 00: 36:00.0C 2161 14604.305
I Kurkino Yellow Stone 90 16.02.2011 09:39:48.000 16.02.2011 10:21:42,000 / 00:41:54.0C 2515 14590. 148
= Kurkino Point_1 16.02.2011 09:43:47,000 16.02,2011 10:22:19.000 / 00:38:32.0( 2313 14559,259
W Point_1 Point_3 16.02,2011 0%:46: 16,000 16,02, 2011 10:22:16.000 / 00: 36:00.00 21561 35.052 -
Fl 11 3
: N Vectors
Figure 48. Vectors

* TVS — opens TVS tab with the information about Survey tab’s objects (see detailed description in
“TVS Table” on page 43).

* NMEA — opens the NMEA tab, where can be displayed the graph for the data of the appropriate
dynamic layer. For the other layer type such graph are not available.

10:36:19 AM
Time:

FInN_ NE Fu
;NMEA|

Figure 49. NMEA
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General Description
View

7.1. TUS Table

The TVS table contains the information about the Survey tab’s objects.

Map |Type |Object |Object data time |P0int name |P0int data time |Layer |Associahed |Recognized audio |C0mment|
TestMap 2 L T8 13.01,2012 14:29:57.000  Selection I
TestMap 2 L P2 13.01,2012 14:29:56.999  Selection I
Lo L[ e 5010910 £430:57.000 T N
_| TestMap 2 L P3 13.01,2012 14:29:57.999  Selection I
_| TestMap 2 L P4 13.01,2012 14:29:58.001  Selection I
TestMap 2 C-\' Parc4 .01.2012 14:29:59.9 13 13.01,2012 14:29:59.001  Selection I
: TestMap 2 OO Pppp2 .01.2012 14:29:59.0 7 13.01.2012 14:29:55.000 | Selection -
_| TestMap 2 C-" Pppp2 01,2012 14:29:59.0 Retegl 13.01,2012 14:29:59.000  Selection -
_| TestMap 2 C-\' Pppp2 01,2012 14:29:53.0 [ 13.01,2012 14:29:59.001  Selection I
_| TestMap 2 C-\' Parc4 .01.2012 14:29:59.9 15 13.01,2012 14:30:00.000  Selection I
_| TestMap 2 C-\' Parc4  .01.2012 14:29:59.9 15 13.01,2012 14:29:59.999  Selection I
_| TestMap 2 C-" Pppp3 01,2012 14:30:02.0 8 13.01,2012 14:30:00.000  Selection I
| 4
| % TS |
Attributes |50Iuﬁ0n |Sty|e |C00rdinahe system |JPS |Med|Picb.|res |snaped to |Laﬁb.|de,° Longitude,®  |Height, meters |Base Snaped to |Laﬁb_|de,°
Ismeretlen - 55.791699437 | 37.526455297 173.2286
Ismeretlen = 37.526864068 172.8866
B | ismerctien USRS —————— 37.526740733 i S | f—
Ismeretlen » 55.791913629 | 37.526993964 172.9844
Ismeretlen - 55.791897964 | 37.527124984 173.1521
Ismeretlen * 55.791792017 | 37.526931674 174.6214
Ismeretlen * 55.791786140 | 37.526973393 173.9694
Ismeretien - 55.791822652 |37.526942052 173.8159
Ismeretlen * 55.791791843 37.526927901 173.8973
Ismeretlen * 55.791819618 | 37.526998044 173.8791
Ismeretlen * 55.791824432 | 37.526945327 174.3863
Ismeretlen * 55.791781879 | 37.527008373 172.8300
™
| % ™S |
Latitude,* |L0ngib.|de,° Height, meters |Base Snaped to |Laﬁb.|de,° |L0ngib.u:|e,D |Height, meters |Agency |Pr0ject |Creah0r |Receiver Receiver ID
_| 55.791699487 | 37.526455297 173.2286 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
55.791929146 | 37.526864663 172.8866 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
P 55791943226 [37.526740733 S B T T TN
_| 55.791913629 | 37.526993954 172.9844 Unknown Unknown Unknown | UDE_25758 HKTASSAV2FSLAZIW
_| 55.791897964 | 37.527124984 173.1521 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
55.791792017 | 37.526931674 174.6214 Unknown Unknown Unknown | UDE_25758 -HKTAS5AV2FSLAZIW
: 55.791786140 | 37.526978893 173.9694 Unknown Unknown Unknown | UDE_25758 HKTASSAVZFELAZOW
_| 55.791822652 | 37.526942052 173.8159 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
_| 55.791791843 | 37.526927901 173.8973 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
_| 55.791819618 | 37.526993044 173.8791 Unknown Unknown Unknown | UDE_25758 HKTASSAV2FSLAZIW
_| 55.791824482 | 37.526945327 174.3863 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2ZFSLAZIW
_| 55.791781879 | 37.527008373 172.8300 Unknown Unknown Unknown | UDE_25758 HKTAS5AV2FSLAZIW
< +

Figure 50. TVUS
Double click on table item performs the following functions:

* Map — opens the window with map properties.
* Object and Object data time — opens the object properties window.

* Point name, Point data time, Comments, Attributes — opens the window with properties of the
point.
* Layer — opens the layer properties.
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General Description
View

Associated — enables/disables Google Speech and Associated with functions.
* Recognized audio — starts Google Speech (see “Survey” on page 31).

Style- opens layer style window.

* Sounds — opens the window with audio information.

* Images — shows the images.

» Company, Project, Receiver, Receiver ID — opens project properties.

* Type — Opens the Info window, with the text information about object.

When you right-click on the cell JPS, Sounds and Images the standard Windows menu for the files will
appear.

To sort the table, click the right mouse button on the column header. To align the column width press and
hold Alt key and left-click on any location within the column. Use the Shift and Ctrl keys, to select
multiple rows in the table. The following menu will appear:

M Table view properties |

Filter .
Clear recognized text .
Select by Base

Figure 51. Menu

Table view properties - opens the properties window.

Filter - enables filter to display/hide the following parameters:

* Receiver - hides all objects of receivers that do not belong to the receivers of selected objects.
* Map - hides all objects of maps that do not belong to the maps of selected objects.

* Layer — hides all objects of layers that do not belong to the layers of selected objects.

* Point — hides all objects that do not belong to the selected objects.

* Clear — clears the filter to display all objects of the Survey tab.

Clear recognized text - removes the recognized text for selected object(s).

Select by Base - selects all points belonging to the same base station.
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8. Application

8.1. Options

General Description
Application

General functions and options, are arranged in special menu item Options. To open the Options window,

click Application ¥ Options.

Common

The Common tab allows specifying the main parameters and functions of the project:

3 Options [&J ]

» Language - select the interface language from the list of available languages.

Common Import| Coordinate svshem] Geoid | Units I Report] Anhennas|

Language |Eng|ish (United States) v|

V] Open last project
[ Apply last coordinate systems
Compact project database on exit

[ Decimal degrees in coordinates forms
[¥] show scale bar

Longitude range @ -180/180 0/360
[ Button panel in object tree
Ellipse scale 1

[] snap objects range 20 % Pixes

[ K l | Cancel |

Figure 52. Common tab

* Open last project - last project will be opened automatically after Justin Link starts.

* Compact project database on exit - Maximum size of Justins project is limited, you should
compact project to avoid data lost if your project size is close to 2 GB. To reduce the database size
and project size as well, compact the database at time.

* Decimal degrees in coordinates forms - the degrees in the coordinate forms will be shown in
decimal values, otherwise in degrees, minutes, and seconds.

e Show scale bar - activates/hides scale bar.

* Longitude range - switches longitude format.
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General Description
Application

* Panel button in object tree - activates new control for the layers; this menu item duplicates the

right button menu.

B Justin Link - [1]
Project Map View Tools Application  Windows Help

Properties
,\_ Properties N Delete Del | 256.5791
* Delete Export to JPS
Export to JPS Export to RINEX

Exportto RINEX __ Zgom to...

“-% Zoom to... Show track
Show track Remove track
Remove track Raw Data Chart

Raw Data Chart

£ Source |4 Map | i@ Survey| | Latitude: N 55°5402.831847° Longitude: E 37°23'44.

Figure 53. Button panel activated

 Ellipse scale - the scale of the ellipses of error can be set.
* Snap objects range - supplies the function of the point Snap \::;, (switches on/off snapping to
point objects). When the mode of object is activated a red line joints cursor and object.

Import

In this tab the parameters of GNSS file import can be specified:

[ g |
3 Options @

Common| Import Coordinate system| Geoid | Units | Report| Antennasl

[¥] Raise error on unknown tag
[ Interrupt on error

[#] Error message logging

[¥] calculate coordinates

[ 1nvert dynamic/static

Figure 54. Import tab

* Raise error on unknown tag - adds warning to ImportLog.txt file.
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General Description
Application

Interrupt (import) on error. - stops import on error.
» Error message logging - creates ImportLog.txt file in a project folder.

Calculate coordinates - recalculates receiver epoch coordinates

* Invert dynamic/static - fix field operator fault in Stop&Go mode survey Surveyer starts Static
observation with Dynamic mode..

Coordinate system

See detailed description in “Project coordinate systems” on page 75.

Units

In the Units tab the metric units used in project can be selected. Select the units from the list.

I Cptions [&11

Common | Importl Coordinate system | Geoid | Units Report| Antennas |

Length meters ll]
centimeters
feat
inches
kilometers
meters
miles
millimeters
nautical miles
survey feet
yards

e

Figure 55. Units tab
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General Description

Application
Report
In the Report tab the parameters of report can be specified the report format and type:
rE‘I Options @1
Common| Import| Coordinate syshem| Gepid | Units | Report  Antennas
Format Standard -
File Type * byt - Separator 1]

Figure 56. Report tab

» Format - report format can be selected from the drop-down list box. The format can be standard or
special for selected country.

Standard Lw_-]

Standard "

“himl o]
HUMGARY = tut

ey Shim |
Turkey

Poland

Figure 57. Report format and type

* File type (*.txt or *. html).
» Separator - the separator is specified in the edit field.
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General Description
Application

Antennas

In the Antennas tab the type of antenna calibration in specified.
3 Options lihf

CUmmUn| Impurt‘ Coordinate system| Geoid | Units | REpUrt| Antennas

|¥| Absolute calibration

e (i

Figure 58. Antennas

It can be absolute calibration (by default), or relative.

8.2. Reference points

Detailed description see in “Reference points” on page 53.
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General Description
Application

8.3. Antenna list

To add a new antenna to the antenna database, click Options » Antenna list.

[ Antenna properties i x|
P
Model Alias | User defined | Visible | Manufacturer + | Model JPLDM_RA_SOP 2
CHCX900R  NONE CHCX900R  NON v CHC Navigation
- - O & o Alias IPLDM_RA_SOP
CHCX91B  NONE CHCX91B  NONE - ~ CHC Navigation
_|CHCXS 1R MNOME CHCX91R NONE I =2 CHC Mavigation Comment Dorne Margolin with chokerings
HEMS320  NOME HEMS320  NONE [l Il Hemisphere GPS (Rogue, JPL design) retrofit with
— Ashtech LMA {two exist at SOPAC)
_|Hrmvso NONE HITV30 NONE r 7 HI-Target
_|HxCeG4sEA  HxCS HXCGG486A  HXC - cd Harxon
HXCGG486A  NONE HXCGG486A  NOM r ~ Harxon
e HNCGE488A NONE HKCGS433A  NON r I Harxon Manufacturer AlanOsborneAssocdates -
_|mT3750323  NONE ITT3750323 NON r ~ T
_ 3750323 scrs ITT3750323  SCIS r ~ T Rk cn 15.05
KOLKS_T  NONE KOLKS.T  NONE - ~ KOLIDA =
MOVS334CR NOVC NOVSIZ4CR NO' Il I~ Movatel Offsets
"~ |smHss2_7224v3.0 NONE STHS82_7224V3.0N [ ¥  souTH Clsmm L2, mm
_|TPsPc_F1 nONE TPSPG_F1  NONE r ~ Topcon Vertical corr (Ci) 59.85 88,35
TPSPG_F1+GP  NONE TPSPG_F14GP  NC r W Topoon
— Base (ai) 59.85 88.35
TPSPG_S1  NONE TPSPG_S1  NONE [l ~ Topcon
TPSPG_S14GP  NONE TPSPG_S14GP  NC r ~ Topcon Northing 0.58 -0.08
p|IPLDM _RA_SOP 1 JPLD/M_RA_SOP ~ - AlanOsborneAssoc
= ~ | Easting 0.37 -0.59
Add l | Delete I [ Update J Phase center variations l | Diagram
[ 0K ] | Cancel | —
h

Figure 59. Antenna properties

In the Antenna properties window the information about the antennas is presented. Select the antenna
from the list and its specification will be shown on the right.

To add new antenna to the list, enter the antenna name to the Model row. Then click Add and add antenna
properties. New added antenna is marked in the list as user defined.

To delete user defined antenna from the list, select the antenna and click Delete. To update antenna
parameters (except name), click Update. The check mark Visible makes antenna visible/invisible in the
antenna list in the Recordset property window. You can sort data in a table by right clicking field title.
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General Description
Distance measurement

Click Diagram, to see the antenna graph with description of the parameters, which should be enteres for

new antenna:

===

Phase L.
CenierT

Antenna Radius

us

N

e

ofest

E

-Vertical Height ——-

i
=
are
o™

g
s,
Urg,
7, o
Hay
Ok

ARP - Antenna reference Point
SHMP - Slant Height Measurement Point

Survey Point

Figure 60. Antenna graph

9. Distance measurement

To measure the distance on the map use Distance tool. To activate it click Map » Distance.

3 Justin Link - [1]
Map

Project View Tools Options

#% Zoomin
Zoom out
...... MDVE

Show entire network

Set map position / size

Distance

Add layer

Default layers style

Figure 61. Distance
The cursor on the map will be shown as cross-hair with ruler: —b} .

Select the desired point and click left mouse button, then select other point and click left mouse button
again (if the distance of polyline is measured, repeat this procedure for all points).

There are two modes for distance measuring:
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General Description
Distance measurement

1. Free mode — the point is selected on the map without snapping it to the object (the Snap button is
inactive . ):

| #s = & @_ @0 = E:’_ &

Kurkino, || 256.579

Base | 173.766
.
0 kilameter 2 4 B g 10
[ ]
07919.8357 SK-42 | Gauss-Kruger zo... | | [Map horizontal : | 13961.7690 meters + 4783.9722 meters

2. Mode with snapping — the point can be snapped to the object (the Snap button is active | 5 |).

|2 2® 9|0 E =

Furking, || 256579

Akl 173. 766

0 kilometer 2 4 3 i 10
[ ]

18389.7593 | 5K-42 | Gauss-Kruger zo... | Map horizontal ; | 14157. 1077 meters + 4772.5254 meters

After the points are selected, in the status bar will shown two distances: one distance between fixed points
(black line) and second between last selected point and cursor (dotted line). When the distance measuring
is active four modes of the measuring type are available:

1. - Horizontal distance in the map coordinate system.
2. - Slope distance in the map coordinate system.
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General Description
Reference points

3, - Arc length on the WGS84 ellipsoid.
4. - Slope distance.

Click the button with measuring type till desired type appears. To clear figures click right mouse button
on the map. To quit the distance measuring mode, click | | or click Map » Distance.

10. Reference points

There are two reference points repository in Justin Link - program and project. Project property
coordinate systems control allows to exchange reference points easily. Entire program database is under
management of reference points module. Reference points attributes are coordinates, accuracy,
coordinate system and a type of fixing (plan&height, plan, height). We do not edit reference point type in
a project because position tolerance criterium depends on antenna height and offsets. Also we do not
distinguish points by their altitude or by name and use plane tolerance only. This restriction prevents to
avoid a conflict between program and project databases due to several types of fixing.

To add the reference points to the program database, perform the following:

1. Left click the reference points button A\ or click Options » Reference points:

Options | Help
1% Application |
Projection |

Datum

| 4 Reference points |

Antenna list

Figure 62. Options » Reference points
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General Description
Reference points

2. In the Reference points window activate the Reference List tab and highlight Reference points,
then right-click and call the menu. Select Add group.

3 Reference points (e

f Reference List Coordinate systems Point name

v oo —

| Add group Il

IE 4 Import
kL Export [ Add group @
Enter group name:

o ][ o

Sigma E 0.0000
Sigma M 0.0000  Type -
Sigma U 0.0000

| Edit point Add point Delete point

[ ][ o ]

Figure 63. Add group

3. Enter the group name.
Groups are used to simplify the search and copy of the reference points according any criterion:
area, coordinate system, etc.

3 Reference points

E Reference List  Coordinate systems 1
[ERIM|Reference paints

{5 Ref_Points

Figure 64. Group name
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General Description
Reference points

4. Select the group name and right-click to highlight it, them activate Coordinate System tab and
select the needed coordinate system for the point. On the right pane appears the dialog box for the
selected coordinate system:

& B
1 Reference points mlﬂ
Reference List 1 Coordinate systems Point name

Grid

Harthing 12 423 187.2366 meters

Easting 500 000,0000  meters

Height 78137.0000 meters
WGS 84/ UTM zone 1M

:WGS 34(WGS84) / Oblique stereographic

Sigma E 0.0000
Sigma N 0.0000  Type =
Sigma U 0.0000

1 [ i ] vl | Edit point Delete po

Figure 65. Select coordinate system

5. Click Edit point and enter point name, coordinates. Select the point type: plane, height, plane and
height, enter coordinates’s sigmas if needed and click Add point. The point will be added to the
group, and its coordinates will be added to the program database.

& B
1 Reference points mlﬂ
Reference List 1 Coordinate systems Pointname  T1

Grid

Northing 12 423 187.2366 meters
Russia PZ90{PZ90) ;
WGS 84(WGS84) / Oblique stereg | £251NG

A wessa Height 78137.0000  meters
WGES 84 / UTM zone 1IN

500 000.0000 meters

:WGS 34(WGS84) / Oblique stereographic

Sigma E 0.0000
Sigma M 0.0000  Type
Sigma U 0.0000

| Add point ] I Cancel

Figure 66. Edit coordinate system of the point

55



General Description
Reference points

6. Repeat steps above to add more points. The list of these points will be displayed in the group:

-

3 Reference points

Reference List  Coordinate systems

(=38 _,J Reference points

Figure 67. Group of the reference points
Depending of the type of referencing, all points will be marked with the following symbols:
4 - plane and height fixed,
EI- plane fixed;
® - height fixed.

To manage the group of points use the right-click menu. The group can be renamed, deletes, the new
points (*.jst,*.csv, *.txt (see “Import files to the project” on page 60 for the detailed format description)
can be imported to the group; one or more points can be exported to the *.jst file.

~

[ Reference points =TAEE X

-
3 Reference points

Reference List  Coordinate systems
[ El-4.,] Reference paints |

& 2 R e

T1 Rename

:-|7 Reference points
£ Ref Paints

B4 Export

| oK J I Cancel

Figure 68. Right-click menu

The menu can be called by right-click on the point in the list. All operations will be applied to the selected
point.

To rename the point and edit its coordinates and type, select the point in the group and on the right-click
the Edit point button. Refresh the information by clicking appropriate button.

To delete the point, select it and click Delete point.

To save all changes click OK button in the Reference points window, otherwise all changes will be lost.
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3 Reference points

Reference List  Coordinate systems

| Reference points

1 Reference points

General Description
Reference points

To move point into another group (if there are two and more groups), select the point and drag it:

3 Reference points

Reference List  Coordinate systems

Reference List  Coordinate systems

Reference points

=, | Reference points

@ P234

-@ Rass
Ref_Points

Lk T1

Figure 69. Drag and drop the point

The point will be removed from the initial group.

10.1. Swapping points between program database and project

To copy reference points to the project database, perform the following:

1. Click the | to create new project, or « | to work with current project. Alternatively click Proj-
ect » Properties:

-
3 Justin Link - [1]

Project | Map

Mew

View Tools Options W

Open

Close

v Properties

ts  Import files

Figure 70. Project » Properties
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General Description
Reference points

2. Click Reference points button, select the group name and click Iif , to copy it from the program
to the project. The selected object will be copied to the project and 1ts name appears in on the right

in the Project folder.
[ 3 Project properties w1
General || Reference points  Coordinate systems| Time |
[EI---J Available E—}J Project
= Ref_Points
ATt
a2
L@ T3
"
@
’ OK ] ’ Cancel ]

Figure 71. Adding referents

This operation is available for copying the reference points from program database, and vise versa from a
project to the program database.

The reference points from the project can be copied to the program data base (Available), by clicking

Alternatively, drag the object on the left and drop it on the right. The object will be copied.

For the objects in the left part of the window the following menu items are available: Add group, Import
(of the point(s) in .jst , *.csv, *.txt formats or of the group), Rename, Delete group:

-

I Project properties 3 Project properties I Project properties

General || Reference points  Coordinate sys General | Reference points  Coordinate sys General | Reference points  Coordinate sy

Bk J Available |
z

DE

[ ) Rename
@ % Delete group

Figure 72. Right-click menu
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Working with a project

For the objects on the right are available: Import (of the point(s) in .jst , *.csv, *.txt formats or of the
group), Delete group, Delete (point):

XN

% % |
ﬂ Time ﬂ Time ﬂ Time
T [ s
S Re E4  Import = rDJ?C_ — | =i | Project
...... i ~ =l g TR =-£j Ref_Paints
e E T2 [ » Delete group ;FI
H- T RE """ E i i Import E T W& Delete

T @ TEL Import

Figure 73. Right-click menu

To save all changes click OK button in the Project properties window, otherwise all changes will be lost.

11. Working with a project

A project is a database designed for GNSS and survey data management, exchange data and maps with
JAVAD field software, export/import maps to GIS/CAD office applications, documents publishing. One
project only can be opened by program simultaneously.

11.1. New project

To create new project perform the following:

1. Click or click Project » New:

rI:IJust'ln Link - [1]

Project | Map View Tools Options Wind

[ New |

l#| Open t
Close ‘

Figure 74. New project
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General Description
Working with a project

2. Enter the details to the Project properties window (for the detailed description see “Project Prop-
erties” on page 39); in the General tab specify the full path to the project file:

g B
3 Project properties lﬂE_J

General Reference points | Coordinate systems | Time |

Name 1

Creator

Agency

Comment

Created 04.09.2012 18:58:21
Full path C:\Justin Link Projects),

| o ‘[ cancel |

Figure 75. Project properties

In the Coordinate systems tab specify the coordinate systems. In the Time tab set the time system
for the project.

3. To close the project without quitting the program click Project » Close.

11.2. Import files to the project

To import files:
1. Click g L button or click Project » Import files:

3 Justin Link - [1]
Project | Map View Tools Options  Winc

MNew

| Open

Close

v Properties

|k Import files ||
Export to.. L4
G Google Earth

F Bt Alt+X

Figure 76. Import files
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Working with a project

2. 1In the Import files dialog window select the file type and file(s) from the list. Click Open:

f ™
1 Import files I&J
Look in: Met-1 - @ T" g v
e Mame = Date modified Type Size
b V Base 16.02.2011 14:54 JAVAD data forma... 5165 KB :
Recent Places (@ K urkino 1602.201114:54  JAVAD dataforma.. 12602 KB
! & Point 1_ 16.02.2011 14:55 JAVAD data forma... 2408 KB
& Point 2 16.02.2011 14:53 JAVAD data forma... 2829 KB
Desktop [ Point_3_ 16.02.2011 14:51 JAVAD data forma... 2435KB
=
Libraries
A
Computer
p Y
“w
MNetwork
File name: Base - Open
Files of type: | Receiver log files (" jps) - | | Cancel |
<

Figure 77. Specify files of types

* The following file formats can be imported to Justin Link :
» *jps — authorized JAVAD GNSS data;
e ¥ fxt, * csv — coordinates text files;
e *tvs — TVS files
* *kml — Google Earth format
* *dxf— AutoCad format
* *db—TVS card format
* *tracyjob — Tracy format
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General Description
Working with a project

Import of *.jps files

To import * jps format files, select from the list: this type B (it can be associated with such icon), then
click Open. The window with progress status appears. Authorized .jps files only could be imported To
cancel import, click Cancel.

:29:459 PM: Recordset: Base (Epochs: 4268) -
:29:459 PM: Import file "Kurkino.jps”

:129:50 PM: Kurkino: 981888689.00: Bad CRC on tag TC on 1
:29:55 PM: Kurkino: 981888689.00: Bad CRContag TC on 1
:29:55 PM: Kurkino: Loaded: 5.60 sec

:29:55 PM: Kurkino: Crc errors: 2 0.00

:129:56 PM: Recordset: Kurkino (Epochs: 9218)

m

:29:57 PM: Point_1_: Loaded: 1.12 sec

:29:57 PM: Recordset: Point_1 (Epochs: 2313)

:29:57 PM: Import file "Point_2.jps"

:29:58 PM: Point_2: Loaded: 1.22 sec

:129:538 PM: Recordset: Yellow Stone 30 (Epochs: 2515)

5
5
5
5
5
5
5
5:29:56 PM: Import file "Point_1_.jps"
5
5
5
5
5
5:29:58 PM: Import file "Point_3_.jps”™

i T 2

Cancel

Figure 78. Import status

The imported files can be seen in the Source tab, as Recordsets and can be sorted by date or by receivers.
Depending of standalone solution and epoch by epoch position tolerance recordsets fall into static and
kinematic. Static Recordsets are linked to Points on the Map pane according default point tolerance
criterium. Kinematic recordsets with special marker inside are treated as Stop&Go.

If recordset has no standalone postion (no ephemeris, bad raw data) than it is marked with a red circle.

Note: Note: All settings for import GNSS data files see on page 45.
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Working with a project

W _static, % - kinematic, ¥ Stop and Go, and ¥ - no position (for details see “Source” on page 17).

[ sustin tinke - 11 = | B |
Project Map View JTools Options Windows Help
| REF ATl @ NRB| 2@ 0)|SO0E 1 +|FE
] T
& 16.02.2011 Kurking | 256,578,
i-qp Base
Fod Kurkino
4 Point_1
L.4p Point_3
4 Yellow Stone 90
\,, Base | 173.766,
.
0 kilameter 2 4 [ 2
il ‘
i ( Source 1 4 ) Map !& Survey! Latitude: N 55°46'57.353209" Longitude: E 37°34'20.366881" WGS 84 Active layer All
.
Figure 79. Imported GNSS data on the map
* -
Import of *.tvs files

To import *.7vs format files, select from the list this type. It can be associated with [ test tvs icon, then
click Open. The window with progress status appears. To cancel import, click Cancel.

TVS file format- it is special xml-structured exchange format designed for data transfer between
TRIUMPH-VS/LS application and Justin Link. It describes objects geometry, attributes, structure of the
coordinate system. After the retyping *.tvs extension as * kml, it can be viewed with GoogleEarth.
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Working with a project

The imported survey objects can be seen in the Survey tab; on the right will be points, polylines and

parcels on the map displayed:

Justin - [1]
Project Map Wew Tools Application Help

=-[,] Project
[V Fosition
[ site
¥ Stop
[V Reference
¥ Recordset
¥ Geoid
7 Eror elipse
[¥ Edge
7 Trajectory
¥ sclution
[V vector
HELYRAJZISZEM
GAZDASEGI_MS_MELLIAKIPELET
BZEMI_WPBLLET _ IPHTMINY
=4 ) Added Layers
[V Google mep

~ Adjustment \ ) Map K Survey
11 sourcs Process

Import of *.kml files

Morthing: 17381675,7444 || Easting: -3120332,5329

|ed o ® O] P + & =}

g

N £ E — -
| [weses j UTMzone 37N || Active layer i

Figure 80. Imported data on the map

To import files in Google Earth (*. kml) format, select the file(s) from the list: this type is displayed like
& testhkml then click Open. The window with progress status appears. To cancel import, click Cancel.

Google Earth format — is *.kml file, which contents information about geometric objects and their
attributes. The imported files can be seen in the Survey tab, in the folder; on the right will be points on the

map displayed:

) ek
L -L Bl 2031 2110 14,1548
o Lieraed
= Wipgia Rt TP
® Virgeia Apart 78
= g Arpeet ™
7 vegas Aapert
* \ergris Arport B
= iegras Arpeet 62
® ‘ipgnia Mrpert 83
= Vingris Riport B8
[ rrrea Adpert
O vloss Thors B
iy Seae B
& ighoss Soore B7
= ‘il Sore B
= Pl Shore BS
= 'fekey Rors
= i Mg 20150200 GRS 4
a (]
» velies Thore W
& ol Tae 1
* 'Fpliow Sare S0
= inlsw Sore B0

.stun 01 M & ey

64

vedaw SRR

. u::a-Furr-:E'!
i g por ] Mg nia Ao 24

. ~d ‘elire SAore B

gt B3

$ o T |
,_:|_-M?‘,fﬁil‘!‘!‘“ ginia Arport 77
| ;
| { wirgria hport a2
[ " ot sochpeya arpert 78
!

WIF (i gt 0

voliow Skone ¥

Om 1 s 3 L) 5
= f e = e = e

Lkt N SEATS. BT Loragtude: £ 3N IRIHMIT | | Wl i L -]

Figure 81. Imported data on the map
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General Description
Working with a project

Import of *.dxf files

To import files in AutoCad format R12 (*.dxf) select the file(s) from the list: this type is displayed like
agtest.dxf , then click Open. The window with progress status appears. To cancel import, click Cancel.

Exchange Format DXF-files (AutoDesk company’s format for AutoCad) - a file format with the extension
*. dxf, which contents geometry information. Before import the coordinate system should be selected in
the window Select the coordinate system.

If you need to swap the axes (YX to XY), activate Import XY (lower left corner of the window). If you
need to invert the coordinates system (i.e., X axe goes to the South, Y axes goes to the West), activate
checkbox Inverse, then click OK.

3 Select a coordinate system =anes X

XYZ BLH Grid
E

Russia P2
WGS 84

[V]1mport Xy [V] Inverse [ Ok ] I Cancel |

Figure 82. Select coordinate system

The imported files can be seen in the Map tab; on the right will be points on the map displayed.

Import of *.db files

To import NS3-files (TRIUMPH-VS/LS application database) select the file(s) from the list: this type is
displayed like |%ldata.db), then click Open. The window with progress status appears. To cancel import,
click Cancel.

The NS3-files - it is special exchange format between external device and NS3 software. It contains
geometric objects, their attributes, structure and description of the coordinate system. The imported files
can be seen in the Survey tab; on the right will be points on the map displayed.

Import of *.tracyjob files

To import files in the Tracy software format (*.tracyjob), select the file(s) from the list: this type is
displayed like [=]test.tracyiab ), then click Open. The window with progress status appears. To cancel
import, click Cancel.

TracyJob-files it is special exchange format of the project created using JAVAD GNSS Tracy software.
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The imported files can be seen in the Survey tab; on the right will be points on the map displayed:

— = -
= .'ml 14
= Sarvery Poirts
= 20
& 21
.22
0 ey
+ Wk
0w 2
Ll Source | 0 Map| B Sorvey Lakdudhe: W 559755, 2801017 Longiade; € 3793114, 21 16447 | |'WG5 84 ]

Figure 83. Survey data on the map

Import of text files (coordinates and comments)

Text data (coordinates and comments) can be imported to the project. To import text files perform the
following:

Click the button | £ L or click Project » File import. Select the file from the list (Coordinates) and click
Open. The window with progress status appears. To cancel import, click Cancel:

i 3 Import files M“
Look in: | 2 Data_Files for Justin Link - & 5 il sl g
P= Mame = Date modified Type Size -
el 123 31.05.201211:17 @aiin KML Google... 150 KB
RecentPlaces &) coordinates 07.04.2011 1336 Microsoft Office E... 1KB
! _ Coordinates_converted 25.04.2012 16:29 Text Document 1KB
E E csv 25.04.2012 16:30 Apxng ZIP - WinR... 1KB
Desktop || layer design points 29,08.2012 17:51 Text Document 1KB
s i layer-1 13.02.2012 14:49 Text Document 1KB
j .:E.Ji . layer-1_converted 04.04.201217:48 Text Document 1KB
Libraries layer-2 30.05.201211:18 Text Document 1KB |
| layer-3 26.04.2012 18:22 Text Document 1KB
:* || layer-4 26.04.2012 18:20 Text Document IKB | (8
Computer | Primer PNEZD 20.03.201217:20 Text Document 1K |~
- | T_Palace 03.05.2011 12:46 Text Document 1KB
(&' Way 01.06.2012 15:51 ®aiin KML Google... 2k LS
MNetwork
File name: layer-1 b
Flesoftype:  [Coordinates [*bd, *.csv, Al Fies) «] | Concel |
. - Receiver log files (" jps

Coordinates {"txt. *.csv.
TVS File {"tvs)

Kmiiles (*keml)

DXFiles (*.dxf)

NS 3Hiles (*.db)
TracyJobdiles (" tracyjob)

Figure 84. Text file import
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Select the coordinate system:

XYZ — cartesian
BLH — ellipsoid

WGS84.

(443 parameters).

-
1 Select a coordinate system

XYz BLH Grid
WGES 84 Zone
WGS 84(WG534) / Oblique

o ][ o= ]

Figure 85. Select coordinate system

General Description
Working with a project

Grid — a cartesian coordinate system based on map projection and 7th parameters global to

Local - a cartesian coordinate system based on map projection and two datums - global and local

Select the coordinate system from the list and click OK. #xt data format template window will appear:

f B
1 txt data format template @

Template Fields
] Column Value ]

L

o add | wadd | [ ek |
Decimal Separator
Separator
’ oK ] l Cancel ]

Figure 86. ixt data format template
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Depending on data order in lines create a template:

& layer-1.txt - SciTE

File Edit

=

Search

x| &|

View Tools Options Language

| Q a®

Buffers

Help

h,6198810.
3,6198802.
5,6198735.
7,6198737.
3,6198506.

m-qmul.hwm—D

To ignore the data from any column in the file, mark it as Empty. Comments and attributes will be merged

1647 ,7399743.
1176,7399825.
2402 ,7399734.
3541,7399829.
1582,7399730.

2720,0.
6952,0.
5446,0.
3020,0.
0614 ,0.

0000, Pointl
0000, Point3
0000, Points
0000,Point?
0000,Pointd

comment
comment
comment
comment
comment

11,6198724.5501,7399789. 7985 ,0. 0000,Pointll comment
13,6198769.4412,7399822. 0028, 0. 0000, Pointl3 comment
15,6198769.7198,7399739.6591,0. 0000,Pointls comment

F Bl
1 txt data format template [ﬂ_&J
Template Fields
| column Value -
1 [Point name
2 Northing
3 Easting
4 Height
b 5 |Comment lz‘
Empty -
Paint name il 2
Morthing =3 |f=-
Easting |
Height =
Humber Line =
g Add ‘ | $¢ Delete ‘ [ g Add ‘ | $¢ Delete ]
Decimal Separator
Separator 5 [T space [Fl1ab
[ 0K J l Cancel l ’ Visual Import |

Figure 87. ixt data format template window

is some columns are marked as Comments and Attributes.

Click Add and enter template name, click Add button on the right (in the Fields pane) as many times as
fields should be added, then by clicking on each separate field choose the field name from the drop down

list, and click OK:

If numeric values has been well recognized by Justin Link, and the points, which coordinates were

imported, will appear on the screen; in the Map tab will be displayed initial file path and name:
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Project Map \View Tools

Options

s vBeBACTOE S

B4 Project
Position
Site

Stop
Reference
Recordset
Geoid

Error ellipse
Edge
Trajectory

Solution
| RV S

----- 4 ) Added Layers

o D:\GIS\ustin Link manual\2 Data

Windows

Help

Figure 88. Initial file path and name
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11.3. Template configuration

The Txt data format configuration window consists of two panes: Template and Fields. On the left
(Template) there is a list of templates and buttons, which allow adding/deleting templates, on the right
(Fields) there is a list of filed and add/delete buttons as well. The set of fields depends of importing data.

3 txt data format template [ﬁj
Template Fields
] Column Value ]
L
s Add | | $¢ Delete H g Add ‘ | $¢ Delete ‘
Decimal Separator
Separator
0K

Figure 89. ixt data format template window

To add new template click the Add button on the left. In the New template window enter template name
and click Ok.

3 MNew template )

Enter new template name
test

e | e

Figure 90. New template name
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In the list of templates appears new line:

[ [ txt data format template I&r
Template Fields
test | Column Value |
)
= Add ] [ $¢ Delete ] [ g Add ] [ $¢ Delete
Decimal Separator
Separator |
[ OK ] I Cancel ‘ ’ Visual Import ]

Figure 91. New template is added

To add a field to the template click Add button on the right. Empty columns will be added to Column list.
Click Value cell. Using ]E" select type from the list. Type a separator of parameters and a decimal
separator. If you want to use space or tabulation as a separator, leave the field empty.

- -,
3 txt data format template I&J
Template Fields
test Column Value B
| 1 Point name
| 2 Latitude, =
| 3 Latitude,'
| 4 Latitude,”
| 5 Longitude, ®
| 6 Longitude,' | &
] 7 Longitude,” E
e Add ] I $ Delete H g Add ] I $ Delete ]
Decimal Separator
Separator |
k.

Figure 92. Fields of a template

Below are listed the parameters using for import:
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Reference points Local points Classifiers
= Empty Y

Point name ) Pmntl namﬁ_ Mumber Line

Morthing Lacal nu:urt_ ing Srale

Easting Local ea_stlng Code

Height — Local height _ Description

M #

SE ¥

50 £

Tpe bl Type b’

BLH Coordinates XYZ Coordinates Plane coordinates

Er I - |
Eoﬁt ga"le Paoink narne 0 Paink narie B
Lattude.” = x Northing

P i Easting
Latitude, Heinht
Longitude, ® z . =10 .

. Y ber Ling
Longituds, Mumber Line Tum|
Longitude,” Cormment Carnrment
Hei ght ! Recoqnized audio Recognized audia
Niber Line Attributes _ Attributes _
Time ol Time V]

Comment
Recognized audio
Attributes
Time hud

Figure 93. Parameters

To delete the template than focus on it and click the Delete button on the left. To delete the field, select it
and click Delete button on the right.

If you suspect that imported file structure can be irregular, the visual import can be performed, the Visual
Import window appears:

File  Template
T SO
15198310, 1647, 7399743, J‘B.D 0000,Point 1 o Point name |Marthing, meters |Easting, meters |Height, meters  |Attrbutes 1
= | GIEHI0. 1647 | 7399743.2720  |0.0000 Font] comment Empty

-] 51933021176 7308825.6052  0.0000 Point3 commeni 7 Point name .
leém;;;lﬁm?;;ﬁ;:umﬁﬁn ||| BIYEPE5,2902  7I99734.5446  0.0000 Fomts commeni | Northing, meters
13,6198765.4412,7399822.0023, n m,Pontﬂ - -] 6153737.3541 | 7355830.0020  |0.0000 Paint? commeni R Easting meters

; o] BI9ER0G. 1562 | 7399900614 | 0.0000 Pomgconment - L et

M 6198724.5501  7399789.7585 00000 Pont1 L commet i

H 61907694412 | 7393812.0028  0.0000 Pontidcomme{ ~ Comment

m 61087657198  7I95739.6891  0.0000 PomL15 comme: Recognized audio

A Attributes

Figure 94. Visual import

This window consist of three work zones: tool bar (above), source text data on the left pane, and a table
with recognized items on the right.

Tool bar has the following items (left to right): Open file, Close file, Exit, Recognize (data), Import,
Template (list), Save Template, Delete, Separator, etc.

3 Visual Import [‘:' =] &J
File Temlate

3 { e | e, i | . .

¢ @ ﬁ . 9 ‘f |Template test - H * Separator [[]Tab [|space Decimal Separator Amountline |1 -

Figure 95. Tool bar
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These buttons are duplicated with the menu items:

r

3 Visual Import [ Visual Import
File | Temlate File [Temlate |
Open Identify
Import
Close
Export

Exit

Figure 96. File and Template menu items

By opening the visual import window, on the left there is coordinates text file. It is possible to select the
strings for import (All lines: press and hold Alf+Shift, or right-click and select the menu item Select all,
select the strings by pressing Ctrl). The name of a template can be specified (in the Template window). If
the template is not specified, set the separators, define the number of merged strings, and click the button
The selected lines will be duplicated ro the right pane. If the template was specified, the columns will be
arranged accordingly, otherwise every column will be marked as Empty, and you will be able to change
the heading to any parameter from the drop-down list.

Use the right-click menu to operate with the objects:

»N  Clear |
== Delete Row Del
T+ Alignment Alt+Mouseleft |

Figure 97. Right-click menu

* To delete the whole list of the data, right-click to call the menu and click Clear.
¢ To delete the row, click Delete Row.
* To align the columns click Alignment.

Click the import button 4g , after all values are defined in the table. The coordinates will be imported to
Justin Link, the points will appear on the map.

To save the template click p=4.
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To define the decimal digits and recalculate column value according a formula specified by customer,
click on the column header and select Format or Formula:

Empty

Point name
Maorthing, meters
Easting, meters

Height, meters

qREA

Comment
Recognized audio

Attributes

0

0.0

0.00

0.000
0.0000
0.00000
0.000000
0.0000000
0.00000000
0.000000000

| Format

Jr Formula

I i A i (i B

Figure 98. Format

If the Formula item was selected, the window Enter the formula appears. Enter the formula to the edit
field. V - it is sell value in the selected column.

= Enter the formula §|

Example :

"¢ BRCT AN TARN 45)1-ARCSINGSING 45+
ARCCOSCOS(45))+SORTESORI45) 1+
ROUMD{45.11 11 INT(45.1111)-
FRAC(45, 1111 TRUNCE 45,1111+
AESE-451+LN(EXPE 1 H-LOGE10)~2

o J[ cra |

Figure 99. Enter the formula

If a template could not be applied to some strings, the next warnings will appear:

Mj LoglmportTxt - Notepad l =NRCAL X

File Edit Format View Help

Ftring = 1 »»> 777777, 2?7777 : "1" -» No correct -
string = 2 >» 727777, 72777 : "3" —> No correct
string = 3 == 7277?77, 7?2?77 : "5" -» NO correct
string = 4 »» 7?7277, 7?7?77 : "7" —> NO correct
string = 5 >> 727777, 72777 : "9" - No correct
string = 6 »»> 777777, 77777 : "11" -» No correct
string = 7 »» 27?7777, 77777 : "13" -» No correct
string = 8 »» 7?7777, ???7? : "15" —> No correct

= ¥

Figure 100. Incorrect data inserted
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To ignore the data of some column in the file, it is necessary to mark is as Empty. Comment and Attributes
types can be assigned to multiple columns, the contents of these columns will be merged.

You can switch between windows during visual import and perform other actions in the program. To
display the previously hidden window of visual import, click Windows » Visual import.

11.4. Export to file

To export data from the project to some format, click Project » Export to... and select the file format:

3 Justin Link - [1]

l#| Open

Close
v Properties

s Import files
Export to...
G Google Earth

= Alt+X

| C\ustin Link Projects\1jpr

| DAGIS\.A2,jpr

[[] DAGIS\.\12jpr

L] DAGIS\.\Kapkac.jpr T
| D:\.\npoeepka 3_1,jpr

| DAGISW0108_2012 0917 Rogovilll,jpr

Project | Map View Tools Options Windows Help

" Beig E?Dg%&

ESRI Shape
MapInfo TAB
MIF/MID

DXF

Krnl

PMNEZD

Tut

Figure 101. Export to...

Justin Link allows exporting to the following formats:

* ESRI Shape — ARCGIS
Maplnfo Tab — Maplnfo
MIF/MID — Maplnfo
DXF — AutoCad

Kml — Google Earth
PNEZD — text file

Txt — text file.
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11.5. Project coordinate systems

Click Project properties » Coordinate system. Initially the list of coordinate systems in the project is
empty. To add the items to the list, use the folder Favorites. Folder Favorites could be empty too if you
run Justin Link for the first time.

s ~
1 Project properties 2 Zmem
General | Reference points | Coordinate systems ~ Time
| User Coordinate system
- | Favorites
i) | Praject
i Projec Height

Ellipsoid height

Transformations

Mo transformation

l oK ‘ | Cancel |

Figure 102. Project properties
To add the coordinate systems to the Favorites list, perform the following:

1. Click Options ¥ Application:

Options | Windows  Help
?'_e\_ Application H

Projection

i
i

Datum

4-;‘:‘__ Reference points

Antenna list

Figure 103. Options » Application

2. In the Options window select Coordinate system tab. On the left there is coordinate systems tree.
Global node is for worldwide coordinate systems; otherwise it is Regional, User node contains the
customer’s coordinate systems; Favorites node is for transferring coordinate systems to a project).

The coordinate system icon shows coordinate system type:

. > Geocentric
o ® Geodetic
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« i Cartesian plane
« % Local

. % Height

« 91 Geoid

On the right there is an information related to selected coordinate system. Switch to orthometric in Height
field to apply geoid. Join plane coordinate system with vertical datum from the list of systems.

r -
1 Options @
Common | Import || Coordinate system Geoid | Units | Report | Antennas |
¢ @[l TTRF » | | Datum
i Bl Pz90 WEs 84
. -4 mean sealevel height L
; Projecti
| B4 EGMIG geoid AR
. @ $ EGM2008 geoid UM zone 1N
-1 | Regional Height
&L, | Antarctica Ellipscid height -
‘ I‘J SDL.Im America Transformations
(-1 | Africa
E |_J Asia UTM zone 1M
B[}, | Europe
(Ll | North America
B[l | Oceania
----- & | User
=)+ | Favorites

L.am8 WGS 84 / LUTM zone 1N

4 [m

Figure 104. Coordinate system

Click Add, and the coordinate system will be added to the Favorites. Repeat this with all systems you
would like to add to the Favorites, then click OK.
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Using right-click menu, the folders can be added or deleted from the Favorites. The coordinate systems
can be removed from the folder, imported to the Justin Coordinate Systems format (*,jcs) and exported to
* jes. Info data pane could be hidden to free room for Coordinate System name inspecting:

-

1 Options @
Common | Import || Coordinate system  Geoid | Units | Report| Antennas|

[=1-7] Coordinate Systems

1|1, | Global

o :E: Was F Add Folder
» Delete Del

Import
[ L Export

T

Figure 105. Right-click menu

When the Favorites list is complete, click v | or Project » Project properties. In the Project properties
window click Coordinate systems tab. Select the coordinate system in the Favorites folder and drag it to

the Project folder. Repeat this operation to add more coordinate systems.

I .
1 Project properties Ié]
General | Reference points || Coordinate systems  Time
| User Datum
=8 J Favorites WGES 84
P WGS 84 Projection
----- @ wesss .
. 223 WGS 84 / UTMzone IN UTM zone 1N
- [1] Project Height
..... G WES 54 Ellipsoid height
----- WGS 84 -
HWwas 54/ = Transformations
UTM zone 1N
[ OK ] [ Cancel ]

Figure 106. Project properties. Coordinate systems tab
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To switch between project coordinate systems, right-click on the window with the list of available
coordinate systems and select the needed one. The position coordinates values will be shown related to
active coordinate system.

Om 20 40 =]
F——
Morthing: 338603950.8612 Easting: -106394170. 7443 WiES &4 Eyer all

TTTTTTTTTTTTTTTT“F:FT WGESs 84 W

WG584 / UTM zone 1N

Figure 107. Coordinate system selection

12. Exporting data to exchange formats

Justin Link allows exporting project to many popular cartographic data to the exchange formats.

12.1. Export of the objects

Click Project » Export to..., and then select the format the map data will be exported to:

-
3 Justin Link - [1]
Project | Map View Teols Optiens Windows Help

3 o AcTa|

Open

Close
v Properties

s Importfiles |
| Export to... ESRI Shape

G/ Google Earth Maplnfo TAB

B Exit Alt+X MIF/MID
DXF

vl CMJustin Link Projectsil.jpr Kml

Lol CM\Justin Link Projects\8.jpr PMEZD

Lol CM\Justin Link Projects'd.jpr Tt

Ll CMustin Link Projects\7 jpr T

Ll CMustin Link Projects\S.jpr |

Figure 108. Project export

ESRI Shape — ArcGIS

Maplnfo Tab — Maplnfo

MIF/MID — Maplnfo

DXF — AutoCad

Kml — Google Earth

PNEZD — text file, Point Number, North, East, Elevation, Description.
Txt — text file.
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To export a dynamic layer, select the layer in the Map tab, right-click and select Export menu item, and a
format the layer will be exported to.

3 Justin Link - [1]

Project Map View Tools Options Windows Help

B BEE AGCGTOQ & kA

=[] Project
- [w Pasition - =t
¥ site g
.[# Stop
- [W Reference
- [¥ Recordset
[ Geoid
¥ Error elipse e
..[¥ Edge
[ Trajectory
- [W Solution
W Vector

B4 ) Added Laye 3¢ Style
LW 100k-¢
Drop layer

“ Show entire layer

Hide all layers except...

Rename LAk
Export Export to TVS file
Volume Export to TVS

[ Export to Tracy

ESRI Shape

Maplnfo TAB

MIF/MID s
x¢ +.
Kl

Figure 109. Export of dynamic layer

* TVS file - TRIUMPH-VS/LS - Justin Link exchange file format
* TVS - exports the layer to the device (for NS3)
* Tracy - exports the layer to the device (for Tracy)
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To export survey points, switch to the Survey tab and right-click on the Device icon (IEX), Map (M),
Layer ("), or Object (point-* , polyline - T, polygon - G), then click Export menu item and select the
format the points will be exported to:

-

3 Justin Link - [1]

Options  Windows  Help

Acosnofd &

Project Map View Tools

) || B S8

Ei:l--_k Map 2012-02-14 11.08.37

=
=)

v Property

Del

‘s Zoom

& Google Speech
Associated L4
Associate by L4
View Table

""" T —

Yellow Stone 1013
Yellow Stone 1014
Yellow Stone 1015
Yellow Stone 1016
Yellow Stone 1017
Yellow Stone 1018
Yellow Stone 1019
Yellow Stone 1020
Yellow Stone 1021
Yellow Stone 1022

ESRI Shape
MapInfo TAB
MIF/MID
DXF

Krnl

PMNEZD

TXT

TVS file

Figure 110. Export of the survey points

The formats are the same as described above.
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tool (Select in region |‘?{3|) right-click to call menu, then click Export menu item and select the format
the points will be exportea to.

79.13.7?._\/;-”@7%% - Yel
W & Addto v Bine 1401 _Ye'@“n' o Sfodhas
N Delete 4n2 Stone 1431\1\9“0\,\ et Og#@ﬁj FzééBB
s Zoom Yellow Stdne 1422 Vellovr St
on Yellgw)Bionadaa2 46 vellow €500
Layer0(53)  * lllow Stong 1426, * Yellow 5t°”*°~\‘é*l1’6ﬂeﬂowé

. »  Delete
= = Yellow Stong . Zoom

p L * ot A5
£ ¥ g a
e N e
ellgWw Stone 1371 = Yellé\p\. tone 14

. llow! Yellow Stone
+ Yellow Stone 136F v!  Property
Syellow Stone 1353

.| & Google Speech

rmeTeea - 1 Associated >
Yellow 5§ Associate by »
View Table LStone 1825
" pustne[ bpet | eRishape
gmsat?gi[)lsﬁ " Yellow Stone 1832 Maplnfo TAB O.VE
MIF/MID ;
vellow Stone 1843 DXF llov
“Yellow Stone 1844 kol 173
Yellow Stone 1845 BREZD
TXT
TVSfile

ns 1170 YolnuotReRe 8837

Figure 111. Export of the points from the map

The output formats are the same as described above.

12.2. Saving file in exchange formats

Save as ESRI Shape

ESRI Shape exchange format (ESRI developed vector data format) is a bunch of files with different
extensions.

kest_Point, dbf kest_Polygon,dbf kest_Polyline, dbf

test_F‘u:uint.shp test_F‘u:uIyg-:un.shp test_F‘u:uIyIine.shp
test_F‘u:uint.shx test_F‘u:uIyg-:un.shx test_F‘u:uIyIine.shx
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Select the needed ESRI Shape format, in the Save As window specify the path and file name and click
Save. The Select coordinate system window appears. Select the coordinate system the point coordinates
will be exported to:

= Select a coordinate system g@g|

v [am o |
WG5S 39

I O l ’ Cancel ]

Figure 112. Select a coordinate system

Save as Mapinfo TAB

MaplInfo TAB format (Pitney Bowes’s format for MapInfo products) is a format of a set of files with the
same name but different extensions. *.TAB file contents associations between all files and file type
information; * DAT contents attribute information, *. MAP contents information about objects geometry.
Object attributes will be exported.

test.DAT =] test.Map
test,ID Ftest. TAB

Select the needed MapInfo TAB format, in the Save As window specify the path and file name and click
Save. The Select coordinate system window appears. Select the coordinate system the point coordinates
will be exported to. If the Add Coordinate System Info check mark won’t be marked, the coordinate
system information won’t be added to the file. If the coordinate system info were added to the file
(enabled), the coordinate system information will be stored in the *.tab file, and will be selected by
default next Justin Link session.

Save as MIF/MID

Another MapInfo MIF/MID exchange format it is a couple of txt files similar named but different
extensions. * MIF file contents information about geometric objects, *.MID contains attributes and
association with * MIF file. For each object its existing attribute information is exporting.

£, test,MID
test.MIF

Select the MIF/MID format, in the Save As window specify the path and file name and click Save. The
Select coordinate system window appears. Select the coordinate system the point coordinates will be
exported to.
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Save as DXF

DXF exchange format (AutoDesk’s format R12 for AutoCad) it is *.dxf file, which contains the
information about object geometry; the attributes are stored as geometric object Text. For each object is
exported names of attribute information only.

s best. dxf

Select the DXF format, in the Save As window specify the path and file name and click Save. The Select
coordinate system window appears. Select the coordinate system the point coordinates will be exported
to.

Set the flag Export XY, to transpose coordinate axes. To invert coordinates, set the flag Invert.

Save as Kml

Kml exchange format (Google’s format for GoogleEarth) it is * Kml file which contains the information
about geometric objects and attributes.

da | kest. bl

Select the Kml format, then in the Save As window specify the path and file name and click Save.

Save as PNEZD

PNEZD exchange format (AutoDesk’s format for AutoCad) it is text file with the information about point
objects. Each file string consist of the columns PointNumber, North, East, Elevation, Description.

[Z] test.txt

Example: 1,55.798484281,37.520853817,377.6407,"Yyy1"
2,55.798480738,37.520859338,378.5889," Yyy2"
3,55.798475886,37.520862463,378.5168,"Yyy3"

Select the PNEZD format, in the Save As window specify the path and file name and click Save. The
Select coordinate system window appears. Select the coordinate system the point coordinates will be
exported to.

Save as TXT

TXT exchange format it is a text file which is configured according a template. Each string contains point
information. Fields are split by separator. By the export of linear objects, each vertex is exported as
separate point.

Example: Yyy1|55.798484281|37.520853817|377.6407|1|comment1|Assoc1|Attribl]|
Yyy2|55.798480738|37.520859338378.5889|2|comment2| Assoc2| Attrib2)|
Yyy3|55.798475886(37.520862463|378.5168|3|comment3|Assoc3|Attrib3)|

1,55.798484281,37.520853817,377.6407,"Yyy1"
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2,55.798480738,37.520859338,378.5889," Yyy2"
3,55.798475886,37.520862463,378.5168,"Yyy3"

Select the TXT format, in the Save As window specify the path and file name and click Save. Coordinate
system dialog appears. Click OK. The new dialog txt data format template appears. Select/create a
template, specify the separators and click OK.

= txt data format template g]
Template Fields

Colurnn | Yalue »~

1 |Paint name

2 Latitude,®

3 Longitude,®

4 Height

5 |Number Line

6 Comment

7 Recognized audio
3 Attributes

s

v

g add ] [ $¢ Delete H g add ] [ $¢ Delete ]

Decimal Separator

Separator Il [space 7ab

o J[ o ]

Figure 113. txt data format template

Save as TVS file

TVS file it is exchange format between TRIUMPH-VS/LS, Victor-VS and Justin Link. The *.tvs file
contains geometric objects, attributes and structure, information about coordinate system.

kest.bvs

Select the TVS file format, in the Save As window specify the path and file name and click Save.

13. Adding temporary layers to the project

Justin Link temporary layers are available during the work session. Its will disappeared automatically
when project is closed. Temporary layers are cartographic layer with the information imported from the
following file formats:

* Tab files — *.tab.
GeoTIFF files — *.tif.
Shape files — *.shp.
Oczi files — *.map.
Maplnfo MIF files — *.mif.
To add temporary layer to the project, click the button + , or click Map » Add layer. Alternatively this
menu item can be right-click called in the Map tab. Take in account that all third party vector/raster maps
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use independent datum lists which could differ from JAVAD company Geo Database, so maps might be
shifted, scaled or rotated related to survey data.

r r

X Justin Link - [1] 3 Justin Link - [1]

Project [Map | View Tools Options Project Map View Tools Options Wir
y Zgom in 5 y I A ;
| e B v | [ERER AL

s= Zoomout L
- E|---.__] Project
= :B..P @ Move | QT ¥ Position
“E & Show entire network | || | e ¥ site
= . PR B | | - |7 Stop
Set map position fsize | || | ¥ Reference
& Distance | || - ¥ Recordset
..... ¥ Geoid
|\"'3 Adddayer. o | || T ¥ Error ellipse
..... ¥ Edge
Default layersstyle | || | i~ ¥ Trajectory
........... ¥ Solution
..... ¥ Vector
----- & Layer 0
----- U ) Added Layer
» Remowve all Del
[ Addlayer
G Add Google layer
¥ GNSS5 Stations
;_ Reference points
Figure 114. Add layer

Select the type and file. Click OK.
"0 Add layer (C5)

Loak in: . Raster Map - & ¥ > [~

o=
= - - - -
Recent Places

Desktop

=

Libraries

A

—

100k--p50-103_1... 200k--n51-05.TAE 200k--n51-06.TAB tl_Point. TAB

m

Computer

Files of type: Tab files " tab) - Cancel

o, =
w

File name: - -

e (_Open |

Tab files (" tab
GeoTIFF files (*1if)

. Shape files {*.shp)
Qzifiles ("map)
MapInfo MIF files (" mif)

Figure 115. Add layer

The added layer will be either vector map or raster image.
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13.1. Formats of temporary files

Tab files

This file format is described above on page 82.

After import of file in 7ab files format to the layers list, the new layer will be added with the name equal
to the file name. If the coordinate system has not been detected by the program (or it was not specified in
the file), the Select coordinate system window appears. Select the coordinate system for the importing
information. Click OK.

[ Coordinate system not found, please choose

XYZ BLH Grid

[ oK ] | Cancel |

Figure 116. Select coordinate system
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In the Map tab appears new layer with imported objects. There is no automatic zoom, so click Show
entire layer.

-
[ Justin Link - [1]

Project  Map View Tools Options Help

#) v | EL'H'T /*\C""'ﬂl:I Q e?'*_ RN R |zd] s @ @__\:3;05§ =1 —|—_ "

B {1 Project
Position
Site

Stop
Reference
Recordset
Geoid
Error ellipse
Edage
Trajectory
Solution
Vector
El-4 ) Added Layers

[ 2l 10ck-—p50-109 \ . S|e

CEEEEEEE L

N  Drop layer Del

“~  Show entire layer

Hide all layers except...

Georeferencing

TVS Background

0 kilometer 1a 20

Latitude: N 60°43'13,645106" Longitude: E 113°49'45,271807" | | WGS 84 Active layer All

i ﬁ Eource! L) Map !IL Survey!

Figure 117. Show entire layer

GeoTIFF files

GeoTIFF is a georeferenced raster image. TIFF format with compression is not supported.

After import file in GeoTIFF files format the new layer will be added with the identical names. If the
coordinate system has not been detected by the program (or it was not been specified in the file), the
Select coordinate system window appears. Select the coordinate system for the importing information,

then click Ok.

In the Map tab appears new layer with imported objects. For imported images there is no automatic zoom,
click Show entire layer.

Shape files

After import file in Shape files format the new layer will be added with the identical names. If the
coordinate system has not been detected by the program (or it was not specified in the file), the Select
coordinate system window appears. Select the coordinate system for the importing information, then

click Ok:
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In the Map tab appears new layer. For imported images there is no automatic zoom, click Show entire
layer.

0zi files

After import of file in Ozi files format (OziExplorer software format of Des & Lorraine Newman
company) to the layers list, the new layer will be added with the name similar with the file name. If the
coordinate system has not been detected by the program (or it was not specified in the file), the Select
coordinate system window appears. Select the coordinate system for the importing information, then
click OK:

In the Map tab appears new layer with imported objects. There is no automatic zoom, click Show entire
layer. for imported files, so click Show entire layer.

(= | e 1] o T P

Project Map View Tools Options Help
] ] EL +T A\\C’/?D Q e-& %%@ 1-’ & O ;052:5:' +

=I- [}, | Project
¥ Position
|7 Site
|7 Stop
¥ Reference
--[¥ Recordset
W Gecid
¥ Error ellipse
¥ Edge
¥ Trajectory
¥ Solution
- [V Vector
=4 Added Layers

N Style

»N  Drop layer Del

|~ ~ Show entire layer

Hide all layers except...

Georeferencing
TVS Background

0 kilometer 20 40 60 80 100 120
e — — S—

| £1 source | ¢y Map k survey | Latitude: N 46°40'56.958681" Longitude: W 6°55'18.762269" WG5S 84 Active layer All

Figure 118. Show entire layer

Mapinfo MIF files

After import of file in Maplnfo MIF files format to the layers list, the new layer will be added with the
identical names. If the coordinate system has not been detected by the program (or it was not specified in
the file), the Select coordinate system window appears. Select the coordinate system for the importing
information, then click OK.

In the Map tab appears new layer with imported objects. For imported images there is no automatic zoom,
click Show entire layer

88



General Description
Register a raster image

14. Register a raster image

14.1. Import of a file without georeferencing

Raster registration is the process of scaling, rotating and positioning the image to match a particular size
and geodetic location.To register a raster image, perform the following steps:

1. Click Tools ¥ Register raster image. The Open dialog window appears.
2. Select the format of raster image file in the Files of type drop-down list.

Note: Justin Link can read the following types of files: BMP, JPG, JPEG, PNG, GIF, TIFF, *.omp 32-bit, and *_tiff
with compression formats are not supported.

3. Select the desired file and click Open. Raster image immediately appears on the map window. By
default it will covers about 75% of map. So you will make a registration process faster if a map have
been centered on right position previously..
3 Justin Link - [1]
Project  Map View |Tools | Options Help
. | i il‘- Register raster image |h
Connectto | é1
...... ‘JE Time conver) i Oper

............................................... LDDk in: | Map - @ ? - EV

L

b

Recent Places

Desktop

'

100k--p50-109 110  200k--n51-05 200k--n51-06
u=al!

Libraries
A

Computer

=
\[¥
MNetwork

File name: 100k—p50-109_110 -

Files of type: [GIF images {*.aif} v] [ Cancel ]

L Bitmap images {* bmp)
JPEG images (*jpa. *jpeg)
PNG images (* png)

ages (*.gif
Figure 119. Supported

4. Enter coordinates of the points in pixels or in geodetic coordinate system in a registration form.
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5. Select the coordinate system available in the project.

3 Justin Link - [1] o e P
Project Map View Tools Options Help
: . — -~ 4 i— — ”
D BERACTOR S WNB| /@O SOEC+ ;
5 a
[\ Pasition
¥ site
- stop
- [¥ Reference
¥ Recordset
W Geoid
i~V Error ellipse
--[¥ Edge
¥ Trajectory
¥ Solution
-[7] Vector
) Added Lavyers
LoV test
Bkilometer20 40— &l 80 100 120 140 160 180
[ ]
Latitude: N 55°11'40.473225" Longitude: E 123°2405.847133" | | WGS 84 Active layer All
L X A= 1P v
Points Map pixels
. . : X ¥
‘Pomt |CSysk |CS\;’sY Pixels ¥ Pixels ¥ |Error | E]
L Map Coord
BLH Grid
' ON
E] Latitude ®s
. BE
Longitude S w
|wes 84 -
4 *
‘ £ Snurtel L) Map |L 5UFVEY| N Georeferendng
.

Figure 120. Raster image

The point coordinates can be entered in three ways.

First way

Zoom in the map area with the known position shape. Click El on the coordinate panel (on the left).
The cursor will transform to cross-hair. Point on the position and double click.

The pointed position will be marked, and in the table new row appears. Coordinates are in screen pixels
and in selected coordinate system. These coordinates could be corrected later.

Such way allows the user not inserting complete values, but editing only the last digits of the input. To

finish point coordinates entering, right-click or click on the

-
To edit the table highlight the needed row. On the right will be
using the following:

button.

the parameters displayed. Change them

» Click Map pixels B, or Map Coord B, select the button on the map and edit the coordinates.
* Alternatively, the coordinates can be changed manually in the corresponding fields. After editing,

click \ U to refresh the image.
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The button »- allows you to zoom the image corresponding to the selected position. In the Scale
window select the zoom.
To save the image to *.7ab or *.0zi files, click rj .

To delete the selected in the table point, use the button
updated to display the calculated errors:

& ; with the button ‘ J | the table can be

Okilometer 1 2 3 4 5 3
| x=947 ¥ =-510 [ ]
Latitude: 5 83°37'50.398297" Longitude: E 166°24'07,029017" | | WG5S 84 Active layer All
% H .0
Points Map pixels
. - . - R . X 493 Y 3609
F‘u:uint 1 Map Coord
_PDint 2 S 55%31'00.000000" W 144°29'00.000000 3948 412 4354 BLH Grid
_ Point 3 5 71%30'00.000000" W 46°57'00.000000" 357 2844 3154 E .
Point4  |571%2200.000000" W 176°25'00.000000" 4135 2373 0 | Latitde : 55 ° &' 0.0000
= ("}
Longitude 5\: 84 ° 51 0.0000
WGES 84 =
F] b

W Georeferencng

Figure 121. Table with the points’ coordinates

Second way (optimal in combination with vector maps)

Switch to snapping mode with . While a point on an active vector layer is in a snapping range of
cursor a distance between the point and cursor is shown like a red line..

Figure 122. Red line hetween cursor and point
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Point with a cursor to some place on the raster image. The object on the active layer and pointed place
will be connected with the blue line. New row with the cursor position coordinates in pixels appears in a
registration table.

=3

Figure 123. Blue line hetween cursor and point

Repeat the steps above with all needed points. The map on the screen will be displayed with the light blue
lines, which fit on image to vector objects. The point coordinates can be edited if needed.

Figure 124. Light blue lines
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To define snap object ranges, select Options » Application, then in the Options window checkbox set

Snap objects range in pixels:

(] Opﬂons]

[S5)

‘Common Import| Coordinate sysh&m| Geoid | Units | Report| Anhennas|

Language |English (United States) -

[¥] Open last project
|| Apply last coordinate systems

|| Compact project database on exit

["|Dedmal degrees in coordinates forms

[¥]show scale bar

Longitude range @ -180/180 T 0/360
["|Button panel in ohject tree
‘E.Iligiescale plal .4
[]5nap objects range PIES pi,ﬂ
-
[ OK l | Cancel ‘

Compact S

Figure 125. Snap objects range

One can easily create new vector layer for georeferencing. If the layer with the points for snapping was
not created, it can be created manually:

Click the button

and select the needed points with the left click. Their coordinates will be added to

the Coordinates clipboard. Later these coordinates can be edited in the table:

Coordinates clipboard

fesl

xH

Height: 0.0000
Height: 0.0000
Height: 0.0000
Height: 0.0000
Height: 0.0000

1. Morthing: -10079347.9093 E asting: 535264.4610,
3 Morthing: -10043877.0188 E asting: 519365.2545,
5 Morthing: -10039529.8400 E asting: 519460.2582,
¥ Morthing: -10037565. 2889 E asting: 5176326470,
9 Morthing: -10038701.3950 E asting: 5188584.1210,

Figure 126. Coordinates cliphoard
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To save the points’ coordinates in a new layer, click - :

1 Justin Link - [1]

Project Map View Tools Option
fE—
Ll E L 'H' L~

=l | Project

----- W Position
..... p Site

..... p Stop

----- W Reference
----- W Recordset
----- W Geoid

----- [+ Errar elipse
----- [ Edge

----- W Trajectory
----- W Solution

----- Layerd
-4 ) Added Layers

Figure 127. New Layer 0

As much layers can be added as needed. All layers elements can be visible, but in the calculations can be
used only the elements of one layer (Active) or all elements of all layers (Select all layers).

To hide the layer, double click on the layer name, to make it visible, double click again.

With the button h the window Coordinates clipboard can be cleared from the inserted coordinates,
and the points selected on the screen will be removed.

To save the inserted coordinates, click ﬂ , the coordinates will be saved in *.tab file. Enter the file
name and click Save:

[ Save As I@
Savein: Map - @ mE-

e L L
Recent Places

Desktop

» Type: TAB File M
100k--p50 Size: 338 bytes n51-06.TAB
~—{ Date modified: 2012-01-18 11:43

=l
Libraries
A
Computer
=
A
Network

il riame: 100k-p50-109_110 -

Saveastpe: | Tabfies [‘tab) +] [ cancel |

Figure 128. Save As window

The window Select a coordinate system appears. Select the coordinate system and click OK. If the Add
Coordinate System Info option is not active, the coordinates system information won’t added to the file
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and Justin Link will ask about coordinate system next time. If this option was activated, the information
about coordinate system will be added to the TAB file.

[ Select a coordinate system =y X

XYZ BLH W

WGS 84/ UTM zona 1M

add Coordinate System Info [ oK l [ Cancel ]

Figure 129. Select a coordinate system

Third way (fastest)

Zoom in the selected area of the map and point with the cursor the point with known coordinates,
checking them in the status bar on the bottom of the window:

04 027 o~ |

|.x=661

=y o e o [
<INmth 61987 East 73997 > | Sﬁ-ﬂsz_a_lTISS_:KI_'I_..IQ_E_I_'_ZE_)I'

Figure 130. Selecting the point

When the cursor coordinates is close to known values (refer to status bar), right-click and move the cursor
to the corresponding place on the image (blue line between points appears), right-click again. New row

appears in the table. Edit this row if needed. Add more control points. The snapping will be shown by
light blue lines.

95



General Description
Register a raster image

14.2. Import of the file with georeferencing

To import to Justin Link a raster image with georeferencing, select Added layers, right-click and select
Add layer. Alternatively, click Map » All layer.

-

A Justin Link - [1] 8 Justin Link - [1]
Project Map View Tools Options W Project |Map | View Tools Options
e
: \;J i L 4'?': e A\ \i \ ¢4 Zoomin
? ] I
= Zoom out
=] Project “
..... ¥ Paosition FI---_J P m Mowve
e & ow entire networl
""" E ore IE Sh k
..... 7 b .~
..... ¥ Reference R Set map position [ size
g Zec?‘;’dset ----- K 2" Distance
..... v Geoi |:
B2t [T |
S i | n
""" I'; ;rTJiCtDW N Default layers style
----- olution
..... ¥ Vector [ ITEjECtory
_____ O W Solution
»  Removeall pel | [ | [+ vector
& Addlayee || ] 8] Added Layers|
G Add Geogle layer
T GMSS Stations
*f_ Reference points
Figure 131. Add layer

Select the file and click Open. The following file formats are supported: Tab (*.tab), GeoTiff (*.tif) and
Ozi (*.map). The files bmp 32-bit, tiff with compression are not supported.

If the coordinate system has not been defined when the layer was created, the system should be selected
in the window Coordinate system not found:

3 Coordinate system not found, please choose | oS e S

o J[ o

Figure 132. Coordinate system selection

After file has been imported, new layer appears in the Map tab (Additional layers node) and the image
could appear on the screen.

If the image does not appear, select the layer and right-click to call menu. Select Show entire layer and
then Georeferencing:
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r -
3 Justin Link - [1] 3 Justin Link - [1]
Project  Map View Tools Options  Window Project  Map View Tools Options  Windows
B | BE®EE AC D REBAC T
E‘"'L_] Project El---._J Project
..... ¥ Position - Position
..... W Site [ Site
..... |7 Stop ¥ Stop
----- V¥ Reference [ Reference
----- ¥ Recordset E Recordset
_____ v Geoid v Teona
B A 1 | W 3nnunc ownbok
----- W Error ellpse ¥ ed
..... ¥ Ed ge
[ g.e ----- ¥ Trajectory
----- V¥ Trajectory ¥ Solution
----- ¥ Solution |7 Vector
= HINZEIVZCLDJF -4 ¥ Added Layers
= m—e LR -
L o ‘: Style } Style
% Drop layer Del *  Drop layer Del

|-“ Show entire layer % Show entire layer

Hide all layers except.. Hide all layers except...

Georeferencing

TVS Background

Georeferencing
TV5 Background

Figure 133. Show entire layer and Georeferencing menu items

The raster image and georeferencing panel will appear.
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The coordinates of the points can be edited, the additional points for georeferencing can be specified.:

| % =404

Om 1 2 3
Y =2833 [ ]
Latitude: N 0°00'01.937935" Longitude: E 177°18'19.0277297 | | WGS 84 Active layer Al
X M .
m (ISR
Points Map pixels
F—— - B X 412 ¥ 427
g Point 1 Map Coord
_|Point2 M 0°00'01,939087" E 177°18'18.915387" 375 2796 a BLH Grid
Point 3 M 0°00'02.013910" E 177°18'19.026300" 3993 371 [u] E - .
Point4 N 0°00'01.937935 E 177°18'19.027729" 4040 2833 0 E] Latitude '?: 0° o' 20121
Longitude © 5\} 177 ° 18 18.916
WGS 84 -
4| k
W Geaoreferencing

Figure 134. Raster image and Georeferencing panel
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14.3. Import of Google map images

To import a Google raster image ensure that your computer has Internet access, right-click on he Added

layers in the Map tab, and select Add Google layer:

=

8 Justin Link - [1]

Project Map View Tools Options  Winc
3
J|BESRIAC
- | Project

----- [V Position

..... ¥ site

..... ¥ Stop

----- [V Reference

----- ¥ Recordset

----- v Geoid

----- [V Error elipse

..... ¥ Edge

----- [V Trajectory

----- [V Solution

----- [ vector

(SRS} Added Laye
...... emove a €
W omstt | W R I Del

¥ Add layer
|(:; Add Google layer
¥ GNSS Stations
4. Reference points

Figure 135. Add Google layer

New node Google map will appear in the Added layers.

14.4. Functions of added layers

There are six functions for raster layers. Google image has an additional Refresh function:

3 Justin Link - [1]

r
3 Justin Link - [1]

Project  Map View Tools Options Windc

ReEAc

v

=L | Project
Position
Site
Stop
Reference
Recordset
Geoid
Error ellpse
Edge
Trajectory
Solution
o
& J Added Layers
- ~
¥ Goot -

»

=

Style
Drop layer Del
Show entire layer

Hide all layers except...

Georeferencing

TVS Background

Project Map View Tools Options Windows
— -
JBRERACT
=4, | Project
¥ Position
¥ Site
|7 Stop
- [¥ Reference
[ Recordset
.. [¥ Geoid
- [W Error ellipse
¥ Edge
- [W Trajectory
W Salution
¥ vector
-4 ) Added Layers
[ test1
Style
»  Drop layer Del
‘-~  Show entire layer
Hide all layers except...
Georeferencing
TVS Background
Refresh

Figure 136. Added layers functions
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* Style- opens the window with the raster image displaying style:

= | Raster style
* e I= 9 | +

Transparency 0%

< >

D Use transparent color

oK 1 [ Cancel l

Figure 137. Raster style

To navigate through the Raster style window use the buttons:

. & show whole picture

e % _zoomin

-

e« = _z00m out

@ - scroll the image. The flag Use transparent color is designed to set the transparent color.
Select it on the image and set the opacity in percent.

* Drop layer - deletes the layer from the program;

Show entire layer - shows all points of the layer;

Hide all layers except ... - hides all layers except selected one.

* Georeferencing - see and change the coordinates and save the changes or save them in the new
file.

TVS Background — saves the data to the *.sqlitedb (for TVS and Tracy background).
* Refresh — for Google Maps only.

Note: Standard path for TVS background: Internal memory: Triumph VS - \Mounted
Volume\Release\BackgroundMaps; SD-card: Triumph VS — \Storage Card\VS Data\BackgroundMaps; Tracy:
Victor —\Storage\Tracy RTK Data\Jobs\*.*; Victor VS — \Mounted Volume\Tracy RTK Data\Jobs\*.*

15. Export of raster Image to TRIUMPH-VS/LS

To export the raster image to TRIUMPH-VS/LS perform the following:
1. Right-click on the layers name in the Map tab, select the TVS Background menu item.
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2. In the Save As window save the file in *.sglitedb format and click Save button:

1 Save As

Savein:

I
=

Recent Places

Desktop
=
Libraries

A

-

Computer

@

MNetwork

LX)
| Raster Map - @ T G-
Name ‘ Date modified Type
Mo iterns match your search,
] n b
File name: 100k—p50-105_110 - Save
Save astype: [TVS Baclkground {~ sglitedb) v] [ Cancel ]

The progress bar appears:

Figure 138. Save as window

Figure 139. Progress har
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3. After file is saved, switch on TRIUMP-VS, connect it to PC via USB cable and start Mobile
Device Centre. Open the File Manager and select the folder according to the path specified in step
above: \Mounted Volume\Release\BackgroundMaps; or \Storage Card\VS Data\BackgroundMaps

" &) Windows Mobile Device Center

Windows

w Mobile®

o
E

en

L
[OS Mabile Device Settings
o

« Connected

Figure 140. Windows mobile dialog window

4. On the PC open the folder containing the file for export, drag and drop it to the TVS window:

-

= @ s

'@®v| )i *« Release » BackgroundMaps

- ‘ 43 | | Search BackgroundMaps

sl

= =T )
E

5. Since raster image export has been completed, it will be available in TRIUMPH-VS/LS as back-

ground map.
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0 Favorites t ‘;\S’L'll_‘:ég; "
= ile
B Desktop B 143 MB
' Divinilosds - Organize | | Open E-mail Burn New folder =« [ 0
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e cert Places L= i Favorites (= I’ ‘ Py
| | | |
| B Desicop H & | /
- Libraries 1§ Downloads | 38 !
@ Documents pi & |
1| Recent Places i
D L | Enul BB e
=t + Copy . testl testl-1.sqlitedb testd
Zitems .l Libraries S
P @ Documents
Jﬁ Music
L testl-1.sqlitedb Date modified: 26.09.2012 19:30 Date created: 26.09.201219:23
SQLITEDB File Size: 68.5 MB

&)

A -
'{(.)j,el Mob
o

ile Device Settings

Figure 141. Export of the files
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16. Data Import and Export to TRIUMPH-VS/LS and Tracy

Connect TRIUMPH-VS/LS or Victor to PC via USB port. Then in Justin Link click on the button I, to
connect to TRIUMPH-VS/LS, or g to connect to Tracy.

The list of the maps (projects) will appear in the Triumph VS Link window:

Triumph VS Link ]

.“9 Map 2012-02-14 11.08.37
W& Map.2012-04-24 14.05.05
M NewMap 1

M Testant

W Testant2

K NewMap 2

W New Map 120514

W Testpaintl

W MewMap 3

Status

| Import | | Export | ‘ Close | | NewMap | | Others

Figure 142. Triumph VS Link window
It is possible to do the following operations with the connected device:

* Creating new object Map g, .
* To create new map, click New Map button. New map (gray icon) appears in the list of the maps.

Triumph V5 Link 2

-k Map 2012-02-14 11.08.37
-k Map.2012-04-24 14.05.05
M New Map 1

M Testant

My Testant2

K New Map 2

M Mew Map 120914

Wi Testpointl

M New Map 3

‘ﬁ New Map 4

Status

| Impart | I Export ‘ | Close | | MNewMap | | Others

* To edit the map name double click on the map name.
 Select active map.
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* If there is no map selected the warning message appears:

Triumph V5 Link =

[ Map 2012-02-14 11.08.37

A ‘m Map.2012-04-24 14.05.05

[ & New Map 1

[\ Testant

0 :m Testant2 [ 8 Justin Link ﬂ‘
71 ke Mew Map 2
[\ New Map 120914
[\ Testpointi | Mo Selectsd Map
[\ New Map 3 )
[} ﬁ New Map 4

Status | |
— e 0
I Import i ’ Export ] Close NewMap Others

* Import of the maps g to the Justin Link.

* Select the map you want to import and click Import. After import complete, the name of the map
appears in the Map tab:

Project Map View Tools Options Help -
Deaw||at®Acorol ¢ FiR|L2@0|s0E

=-iC0 PO4_X0022
- Map.2012-04-24 14,05.05 i ; .
D:\GIS lustin Link manual\2 D) 3 2

Triumph V5 Link [=]

"] i Map 2012-02-14 11.08.37

|7 *® Map.2012-04-24 14.05.05 Done
7 ks New Map 1

M e Testant

[ M Testant2

0 'm, Mew Map 2

[ kg New Map 120914

[ i Testpoint1

[ i MNew Map 3

=)

=l

Map, 2012-04-24 14.05.05 1 from 1 Time left 00:00:00

L
 —

A meot |[ epot || Cose || NewMap |[  othes |

Figure 143. Import of the map
* Export of TVS-files (*.tvs) to devices.
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General Description
Data Import and Export to TRIUMPH-VS/LS and Tracy

* To export the TVS-files, select the map the data will be exported to, and click Export. In the
Open project window select the *.tvs file and click Open:

s ™y
1 Open project l&]
Lookin: || 2 Data_Files for Justin Link - @ T e m-
= Mame - Date modified Type *
’*}}’  Map.2012-01-13 10.53.55 25,09.2012 19:19 File fol
RecentPlaces | 125 2012-01-1310.54.20 250920121818 Filefol
!  Map.2012-01-20 05.30.44 25092012 19:19 File fol
J Map.2012-02-07 05.18.50 25,09.2012 19:19 Filefol
Desktop | Moscow 31.05.2012 11:42 File fol
— . MAVTECH 20.03.201215:35 File fol
_‘__“_J  Met-1 13.09.2012 18:15 File fol -
Libraries 1 Png 05.06.2012 13:40 File fol
J Raster Map 26.09.2012 16:31 File fol
:_-*.L._‘ | Raster Map_1 26.09.2012 19:30 File fol
Computer | test 06.09.2012 14:49 Filefol |
i |111tvs 28.,04.201217:30 TVSFill_|
4 F
File name: 1 -
Flesoftype:  [TVSfiles (tvs) «] [ Cancal |
A

Figure 144. Open project window

* In the Export to window select the layer the data will be exported to:

r "
3 Export to L |el= g

Layer 1
Layer 2
Layer 3
Layer 4
Layer 5
Layer &
Layer 7
Layer &
Layer 9

o [ e

Figure 145. Export to dialog
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General Description
Data Import and Export to TRIUMPH-VS/LS and Tracy

* In the Triumph VS Link window the message with the export confirmation appears:

Triumph VS Link (=]

‘m Map 2012-02-14 11.08.37
i L Map.2012-04-24 14.05.05 Done
'm Mew Map 1
M Testant
'm Test ant2
K New Map 2
K Mew Map 120914
i Testpointl

Mooz ome

MNew Map 3 2 from 2 Time left 00:00:00

ez [ evessmesses [ ez | e | prm—m——m)

Figure 146. Export into map completed successfully
» Using the button Others it is possible to import database of the coordinate systems, export a data
base of the coordinate systems, export a map file and control points from selected file type.

* To import/export a database of coordinate systems, just select the corresponding menu item. If the
map file (NS3-files,*.db) is importing, select data.db file:

1 Open @
Lookin: |, Map.2012-04-24 14.05.05 - T e
D= Name : Date modified Type
ke ) Default 2012-04-27 1740 File folder
RecentPlaces | 1c4ia 2012-04-2717:40  File folder
! J Pictures 2012-04-27 17:40 File folder
J Raw Data 2012-04-27 17:40 File folder
Desktop %) data 2012-05-31 16:22 Data Base
Librraries
5 1
A
Computer
@
L < | 1[I 3
Metwork
File name: data -
Fles of typs: [ NS3iles (“db) +] [ Concel |
[ a

Figure 147. Selecting the file

* To import set of points to the TRIUMPH-VS/LS and Tracy for further localization:
* Select a map from the list.
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General Description
Data Import and Export to TRIUMPH-VS/LS and Tracy

* Click the Others button and select the file type: standard, txt file, and Pinnacle format.

Triumph VS Link =

k Map 2012-02-14 11.08.37
7| e Map.2012-04-24 14.05.05 Dane
e Mew Map 1
W Testant
M Testant2
M MewMap 2
e Mew Map 120914
W Testpointl

New Map 3 2 from 2 Time left 00:00:00

Import ‘ | Export | ‘ Close | | NewMap Import database of coordinate systems

Export a database of coordinate systems

Export map file
Export local points from 3 Standard
Tut file

Pinnacle

* Standard - it is a comma separated text file with the *.csv file name extension. Each line
corresponds to a single point. The set of parameters contained in the line may be different, only
the first four parameters are mandatory: point name, local coordinates of the North, the local
coordinates of the East, the local coordinates of the Height. There are additional required fields:
WGS84 Longitude, WGS84 Latitude, WGS84 height, type (horizontal and vertical (0), plain (1),
and height (2)). The parameters must be strictly in the order in which they are listed above. Below
is an example of the standard format:

mtl; 36004, 78;27270.732; 20, 382511

Mt2; 35834, 688; 27455, 556:40.157;43. 0567672722222;131. 890276672222 76. 56;
Mt3; 35018, 613; 27647, 065;46, 830;43. 0575247583333:131. DOLA37286111; 74. 5445 0
Mtd:37034.724: 28811, 695:44. 556:43. 0675826388889:131. D1 5908502778; 72. 2981
Mt5: 37000, 278; 28608, 282: 23, 553:43. 068081 A338885:131. 0145153654441 51.307; 2
ME7:37452. 265 28652, 303:2. 048; 1310

Mt8; 37216, 638; 28716.365;18. 872;3::1

MtO; 36434, 262; 26896, 549;4. 8953332

Figure 148. *.csv file

» Txtfile - A text file has no special order of the parameters, it should be the same for all rows of the
file. As separators can be used different symbols. The export from the text file can be done in two
ways: using template import or visual import. Create a template and define the column names.
Specify parameters (see ‘“Template configuration” on page 69). If the visual import is used, more
complex structures can be imported (from the multiple files).

Below is an example of the txt format:

mtl
mt2
mta
mtd
mtd
mt&
mt?
mtE
mto

56094, 78 27270, 752 20,582 45,04591064861111 151,8%7004174 48,105 O
54854, 688 27444 ,446 49,147 45, 0467672722222 151,8595276672222 76,86 1
349l8,615 27647,904 446,859 45,0474247485555 151,9016572860111 74,444 2
57054, 724 28811,6%94 44,446 45,0674826588885 151,914508402778 72,2098 O
37090, 278 28698, 282 25,445 45,068081685385858% 151,914414569444 41, 507 1
57057,49 28864,65 40,81 45,0676082085555 151, 916470719444 78, 541 2
37442, 264 28642, 5050 2,048 45,07155964 151,9159464155858% 29,8218 O
57216,658 28716, 564 18,872 45,069219224 151,914754944446 46,656 1
56454, 262 26896,449 4,894 45, 0021479972222 151,8924044 52,62 2

Figure 149. *.txt file
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Data Import and Export to TRIUMPH-VS/LS and Tracy

¢ Pinnacle format file is shown below:

Table calculator

Left pane :

Geodetic @ wEsSE4

Unit name : Meters

Mame Latitude Longitude Hedight,m

mtl 44°04'42.78444 141°44'40,.21404 48,104
mtz2 44°04'24.46218 141°44'47.49602 76,86
mtd 44042708014 141°44'04,. 59424 74444
mtd  44°04'04. 2974 1417444727061 F2.298
mtd  44°04'04.090408 141°44'42.24444 41,407
mta 44704 '04,.49207 14174449, 64449 75,441
mt? 4404 '16,. 82274 141°44 40, 20709 20,8218
mts 44°04'09.18921 141°44'44.04944 45,646
mtS  44°04'44 . 76879 141°44'42.64944 42,62
right pane :

Local : SK Most

Unit name @ Meters

Mame Morthing,m Easting,m Height,m

mtl 46084, 78 27270742 200487

mtZ2 44844 6088 27444.446 49,147

mtd 44915.601ld4 27F0d7.064 46,549

mtd 47044724 ZEELL. 694 44446

mtd4  4F090,278 28698.282 24.444

mta 4704749 2EE8d.604 40061

mty 47442 204 Z2E804d42.404 2,048

mtE 4721la.ad48 2E871la.46d 18,872

mte 46444 ,262 268946.449 4, 894

Figure 150. Pinnacle format file

Select the layers the coordinates of the points will be imported to (in local and WGS-84 coordi-
nate system):

. _ I -
[ Select layer importing local points = | B |l A Select layer importing WGS84 pomi:lilﬂlﬁ:_hj

Layer 1
Layer 0

Layer 1 Layer 2

Layer 3

Layer 2 Layer 4

Layer 3 Layer 5§

_La er 4 Layer &

i Layer 7

Layer & Layer 8

Layer 7 Layer 2
Layer &
Layer 9

[ QK. l | Cancel
OK l | Cancel |
L=
o
Figure 151. Select layer

After layer is selected, the import starts and progress and appears:

The window will close automatically. To closed Triumph VS Link window, click Close.
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General Description
Data Import and Export to TRIUMPH-VS/LS and Tracy

16.1. Dynamic layers export to TRIUMPH-VS/LS and Tracy

To export dynamics layers to TRIUMPH-VS/LS and Tracy, click right mouse button on the dynamic layer
name in the project pane and select Export menu item, then Export to TVS or Export to Tracy:

B3 Justin Link = [1] =
Project Map View Tools Options Help

D v REHAC Ol & RE

|| =L Proect
¥ Positon
P Site
P stp
F Reference

I Recordset
F Geod

F Emor elpse
 Edge

W Trajectory
F Solution
F Vector

) Added Layen 3 Style
N Droplayer Del
~ Show entire layer
Hide all layers except...

Rename
[ Epon Export to TVS file

Volume Export to TVS
Export to Tracy
ESRI Shape
Mapinfa TAB
MIEF/MID
DixF
Kml
PNEID
TXT

Figure 152. Dynamic layer export

The dialog Triumph VS Link with the list of the maps will appear:

3 Justin Link - [1] =

Project Map View Tooks Options Help
| BERACTOR S NRRB| 4@ 9| ¢

=i Project

[ Positon Triumph VS Link B
[ site [ e Map 2012-02-14 11.08.37

g ;f;,m [ bl Map.2012-04-24 14.05.05

¥ Recordset e New Map 1

F Geoid ] M Testant

g :ﬁ elipee e Testant2

[ Trajectory 1 i NewMap 2

W solution [ ! New Map 120914

F vector I aa Testpomtl

D:\GIS\Justin Link manual\2 Data_
v ) Added Layers

Stabus

Figure 153. TRIUMPH-VS/LS Link
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General Description
Report

Select a target map (or several maps) and click Export. If the information was transferred successfully,
next to the map name will be shown Done.

17. Report

There are two types of format for reports in Justin Link. Click Options » Application » Report and select
the format. It can be *.£xt or * html.

To generate a report, click i | button on the tool bar and the Report window appears:

3 Report =TAEn X
Source  Coordinate system | Time
Gis
SR = |PO<4_X0022 | N L] Repart
—k Map 2012-02-14 11.08.37
+-4  Layer 0
—k Map.2012-04-24 14.05.05
¢ B DiGISJustin Link manual\2 Data_Files |
+-,_ Cnoid
=i Mew Map 1 )
- Layer 0 v
453 LayerD =
7| T [3
(Bl | Go | | Close |

Figure 154. Report window

* Source tab: On the left there is the tree with items of the project. On the right there is the Report
folder and mix set of the selected items.
At first, the Report window is empty. Select an object on the right and click | g . This item will
appear on the right. '
To delete the items from the report pane, select them and click 4 .
To set the table parameters click| N ‘ and the Table parameters window appears.
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General Description
Report

* In the Coordinate system tab the coordinate system for report is defined:

-
I Report

Source || Coordinate system  Time

= | B [t |

wz | B

¢ Local |

SK-42 | Gauss-Kruger zone 7 - 36-42%E
SK-42 [ Gauss+Kruger zone 7 - 36-42°E

WGES 84 f UTM zone 1M

Title

Figure 155. Coordinate system tah
* In the Time tab the time system can be set.

-
[ Report

Source | Coordinate system | Time

() GPS time (date ftime)
() GPS time

() GPS time (sec)

@ UTC time

() Local time

Title

Figure 156. Time tab

In the lower left corner of the Report window there is 7itle check mark. This means that the log file will
have a JAVAD logo and title with the general information. If enabled, the file will be created without title.

If the *.html format mode is active, the Add map image flag will be available and the map image will be
added to the report.

-
01 Report [E=E =
Source  Coordinate system | Time
Gis
101 PO4_X0022 =-{J
[l Map 2012-02-14 11.08.37 -0 PO4_X0022
% Layer E-igg Map 2012-02-14 11.08.37
w Map,2012-04-24 14,05.05 -5+ Layer 0
[ D:\GIS\Justin Link manual\2 Data_Files | W Map.2012-04-24 14.05.05
& Cnoid Q D:\GISustin Link manual\2 Data_Files
Mew Map 1 - Croiid
z & Layer 0 * MNew Map 1
[H-_ Layerl \ #- i Layer 0
& [, LayerD
4| i 3 4| ([} b
Title
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General Description
Report

When report design is completed, click Go button and the report will be generated in hfml/ or txt format:
. o o

S L) 2] Custin Link Projects\1_12.09.26_2038_GisReport\1 12,0926 2038 O ~ ¢ X |I = |
1@ ~| - Bserch 7|2 AR(A-E TR ALRD %
f v B -1 & v Page~ Safety~> Tools~ @~ [ (8 & B B w

Project: 1

Program: Justin Link Coordinate system category: SK-42
Version:  1.101.132.2 Link Datum: Gauss-Kruger zone 7 - 36-42° E
J Creator: 5 Units: meters
Agency: - Height type: Ellipsoidal
(v/2\V/2\» B -
Processed: 26 09 2012 20:38:55
Points
Ea(m; Point Time No Northing, m Easting, m | Height, m | Comment | CommentData | Solution Ant.Type Ant.Hgt | Hc
Yelow 5 55 3012 Stand-
Stone e 912 |6187218.4072 | 7407351 1650 3648136 | Point & JAVTRIUMPH_VS 1543 |Ve
1321 20:31:33.999 alone
Yellow 21022012 . Stand-
Stone 20-17-05.000 7898 |6187217.3349 | 7407351.4946 | 364.5936 | Point - | JAVTRIUMPH_VS 1.543 |Ve
1307 R alone

4 - T . l

#100% ~

Figure 157. Report in html format
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General Description
Report

r

"] 1.12.09.26_2037 GisReport - Notepad =EE0 X
File Edit Format View Help
Program: Justin Link -
Version: 1.101.132.2 Link
Creator:
Agency:
Project: 1
Processed: 26.09.2012 20:37:48
Coordinate system category: Sk-42
Datum: Gauss-Kruger zZone 7 - 36-42° E
units: meters
Height tType: Ellipsoidal
Map Map 2012-02-14 11.08.37
Layer 59
PoOints

Point Name | Point Time | No | wNorthing, m | Easting, m | Height, m |
vellow Stonme 1321 | 21.02.2012 20:31:33.999 | 7912 | 6187218.4072 | 7407351.1650 | 364.8136 |
vellow Stone 1307 | 21.02.2012 20:17:05.000 | 7898 | 6187217.3349 | 7407351.4946 | 364.5936 |
vellow Stone 1334 | 21.02.2012 20:45:00.999 | 7925 | 6187219.4328 | 7407350.6690 | 3265.7061 |
vellow Stone 1333 | 21.02.2012 20:43:58.000 | 7924 | 61B7219.7972 | 7407350.5042 | 3265.6744 |
vellow Stone 1332 | 21.02.2012 20:42:56.000 | 7923 | 6187219.1927 | 7407350.8803 | 365.5182 |
vellow Stone 1331 | 21.02.2012 20:41:54.000 | 7922 | 61B7218.6885 | 7407351.1576 | 365.5954 |
vellow Stone 1330 | 21.02.2012 20:40:53.000 | 7921 | 6187218.8061 | 7407351.1442 | 265.7680 |
vellow Stone 1329 | 21.02.2012 20:39:50.000 | 7920 | 6187218.9294 | 7407350.8542 | 365.4393 |
vellow Stone 1328 | 21.02.2012 20:38:48.000 | 7919 | 6187218.9576 | 7407350.8723 | 365.2151 | |-
[ e e L ;

Figure 158. Report in txt format
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